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Distribution Concepts

O Data Distribution is accomplished at the Distributed Active Archive
Centers (DAACS).

L DAAC Operator manages order distribution requests using a web
browser and performs direct updates to the Order Manager Service

(OMS) Database.
O The Order Manager Service (OMS) manages all data orders via:

» EWOC [EOSDIS ClearingHOuse (ECHO) Web Service Distribution Language
(WSDL) Ordering Component (OC)].

» Data Pool (DPL) — talks directly to OMS and stages granules.

» Spatial Subscription Server (NBSRV) — talks directly to OMS; automatic
product request generated based on subscription criteria.

» Science Command Line Interface (OmSCLI) — allows acquired products by
Order Manager Server.
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Distribution Concepts

(cont.)

1 OM Server validates all data order requests received into the OM
Subsystem (OMS), then dispatches each validated request to the
appropriate order-fulfillment service.

0 OMS manages distribution of data by two methods:

1 — Electronically (directly distribute data from staged files linked to DPL
storage directory):

—  FtpPush/SCP
—  FtpPull.

2 — Physical Media (created by the Production Module Device on physical
media): —

— Digital Linear Tape (DLT)
— Digital Video Disk (DVD) s §not utiized ny LaRO,
_ Compact Disk (CD) but at all other DAACs
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Distribution Concepts

System Context Diagram (cont.)

Data
Providers

User =
=] f I
m
FOR.  ppRp, @A
| z : Granula  pay Updats
parators (ftp.cp) {ftp.mcp (amail)
DN,Granulas_, amail) I ECHO
(ftp, scp,amail) " —

Matadata

Orders
ECHO itepdp)

Tape

Archive
Procassing Storkext
Roguests F'rncassmg i it

/ Raguests

OAAC
on-Demand
Procassing

» = Discovery (DPL drill down)
= Data Ordars

= Jnrdemand Processing

= Jrdar Status Inquirias

=Direct Downloads

Granules Matadata
Metadata (ftp I:httpj

LEGEND
I0E = Bulk data flows 8

625-EMD-204 Inte —  0ntrol flow s, Massagas U Shens 5




Order Manager Subsystem

Support for External Processors

1 OMS manages order from WIST, ECHO and the External Processor
via EWOC (including hard-media orders and HDF-EOS to GeoTIFF
(HEG) Conversion Tool orders).

O OMS stages each order to DPL storage and creates links from
staged files to the FtpPull directory or distribution.

O OMS Graphical User Interface (GUI) allows managing and
distributing orders directly to the OM database.

O EWOC registers external processing “orders” with OMS.
O EPD registers external processing “outputs” with OMS.
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Order Manager Subsystem

Support for External Processors (cont.)

O OMS distributes external processing outputs like any other data
(e.g., HEG processing outputs):

» OMS displays external processing orders with associate labels.
» DAAC can configure separate DN preamble, FTP Pull expiration.
= Operator actions are disabled until OMS has control; No resubmit.

» Operator can suspend/cancel/stop/resume acceptance of orders for external
processor.

1 Some Support for ASTER On-Demand.:
» No granule identifiers in DN.
» [.REQ)] file is not distributed.
* PDR changes (backwards compatible).
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Order Manager Subsystem

Flow Diagram
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Order Manager Subsystem

OM Server Components

O OM Server has four major parts:

1 — Sybase ASE Server:

- COTS SW application handling order management-related interactions with
the Order Management database.

2 — Order manager (OM) GUI:
- Allows viewing and modifications of requests by Operator.
- Permits suspend, resume, cancel, resubmit or modify functions.

3 — Physical Media Device (Luminex):
- Transfers products electronically.
- Transfers digital products to three physical media types.
- Prints labels and inserts for physical media distribution.

4 — OMS Bulk Browse Utility (ECSBBR):

- Extracts browse cross-reference and copies into DPL(SAN) non-existing
browse granule files.

- Updates granule files list in OMS to include DP copied files.
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Order Manager Services

OM GUI Functionalities

1 General functions and processes associated with data distribution
operations can be performed as follows:

» | ogging into the system.

» Viewing/Responding to Open Interventions

» Viewing/Filtering Completed Operator Actions and Interventions

» Viewing/Filtering Distribution Requests Data

» Filtering Processing Service Requests

» Filtering FtpPush/SCP (or Staging) Requests

» Handling Operator Alerts

» Viewing/Responding to Suspended FTP Push Distribution Destinations
» Viewing Historical Distribution Requests

» Viewing Historical Processing Requests

e
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Order Manager Services

OM GUI Functionalities (cont.)

1 General functions and processes associated with data distribution
operations can be performed as follows:

» Viewing/Modifying OM Queue Status

» Viewing HEG Order Status

» Viewing Staging Status

» Viewing Pending HEG Granules

» Viewing Data Pool File System Status

= Checking/Modifying Assigned Values of Aging Parameters

» Checking/Modifying Assigned Values of OMS Server and
Database Parameters

» Checking/Modifying Assigned Values of Media Parameters

» Checking/Modifying Assigned Values of Media Creation Parameters

» Adding/Deleting User Email Address that will receive ODL Metadata File
» Adding/Deleting User Email Address that will receive Checksum File

625-EMD-204 Interim Update 1 — LaRC 7.21 11



Order Manager Services

OM GUI Functionalities (cont.)

1 General functions and processes associated with data distribution
operations can be performed as follows:

» Checking/Modifying External Processing Services Configurations
= Viewing/Modifying FtpPush/SCP Policy Configurations

» Using the PMD Media Creation Console

» Filtering/Modifying PMD Device Configurations

» Responding to Open PM Interventions

= Modifying Existing PMD Printer Configuration

» Modifying Existing PMD Production Module Configuration
» Printing PMD Reports

» Adding/Deleting Compressed Format ESDTs

» Viewing Distribution Requests Order Status Pages

= Viewing the OM GUI Log
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Order Manager GUI

System Hosts Login

O Activating the OM GUI requires a terminal with a host logon to
access arecommended web browser, i.e., Mozilla 5.0, Netscape 7+,
Firefox 0.9+, generic “Mozilla” for Linux or UNIX.

O Procedure: Logging into the System
> Enter URL (http://x4iil01.<DAAC_extension>:<port>).
> Enter Security Login Prompt information.
s»Figure: Prompt dialog box

Prompt

@ Enter username and password for "OMS Bealm® at p2dps01.pyc.ecs.nasa.qoy:22421
User Mame:

I Username

Fazsward:

I Password

[~ Use Passward Manager to remember these values.

Ok, Cancel |

> Click OK to launch the Order Manager GUI (Home Page).

|
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Order Manager GUI

OM GUI Home Page

ssFigure: Order Manager GUI (Home Page)
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Order Manager GUI

OM GUI Home Page (cont.)

Order Manager GUI Menu

Navigation Menu Option

U Request Management provide options to manage all validated requests;
provide interventions capabilities; and process subsetting. It also allow
Operators to fix common problems with requests within the OMS GUI.

Submenu Options

=Open Interventions
*HEG Interventions

=Completed Actions &
Interventions

=Distribution Requests [filter]

=Processing Service
Requests [filter]

=FtpPush/SCP
Requests [filter]

=Staging Requests
[filter]

=Operator Alerts

O Destination Monitor provides monitoring capability to suspend
distributions and resume them.

=Suspended Destinations

U  Archive Data is the repository for all historical distributed and processed
requests.

=Historical Distribution
Requests [filter]

=Historical Processing
Requests [filter]

O OM Status Page displays summary information of current states i.e.,
suspended or active, for each media server or email. It also displays each
archive server’s staging status.

=OM Queue Status
=*HEG Order Status
=Staging Status:
—Media Type
—FTP Push Destination
—SCP Destination

=Pending HEG
Granules

=DPL File System
Status

___________________________________________________________________________________________________________________________________________________________|
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Order Manager GUI

OM GUI Home Page (cont.)

Order Manager GUI Menu

Navigation Menu Options Submenu Options

U OM Configuration allows Operator to configure aging rules for each *Aging Parameters *Media
priority level — Aging Parameters; to set database and server parameters, | *Server/Database *Media Creations
which affect the entire system — Server/Database Configuration; and to set ~[AlI] *ODL Metadata Users
and adjust media types attributes — Media Configuration. Provides —[que_lueL [Clé%anUp], =Checksum Users
checksum validation on OMS distributed files, which allow Users to Eggilr%b][m[gaﬁ]tion] =External Processing
perform validity tests against their granules. [misc.], [HEG] =FtpPush/SCP Policy

O Help provide guidelines to using the OMS GUI. =About HelpOnDemand.... =Help

Q Physical Media Distribution controls and some configurations for *Media Creation Console =*PM Configuration
creating and distribution Physical Media. =Device Configuration =Reports

=Open Interventions =ESDT Configuration

=Printer Configuration

O View Order Status provides a visual displayof viewing multiple levels of a | *OM GUI Order Status
particular order status.

O Logs displays a log viewer — a convenient diagnostic tool that displays all | *OM GUI Log Viewer
current activity in the OM GUI. Records of every running page and stored
procedure are recorded in the log file located under « cgi-bin/logs »
directory.

Q Admin Tools administers and maintains FC or LC Operator’s read (r) =Server/Database *FtpPush Policy

. . . Parameters .
and/or read/write (rw) permissions to all fields of every OM GUI pages. =Action Pages
=Profile Management

=Media Parameters
=Aging Parameters

_
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Order Manager GUI

Operator Security

OM GUI Operator Security Capabilities

Role Capability

=Primary level activities do not limited the ability to configure parameters; view all levels

O Full-Capability (FC) of interventions activities; view and change actions for distribution request lists and
Operator detailed information; monitor and configure OM Server and OM Database parameters;
etc.
QO Limited-Capability (LC) =Secondary level activities are limited to the basic functionality of monitoring and
Operator viewing.

=Administers read and/or read/write permissions to FC and/or LC Operators for the

O Administrator purpose of viewing, monitoring, configuring, and/or maintaining all fields of the OM GUI.

|
625-EMD-204 Interim Update 1 — LaRC 7.21 17



Order Manager GUI

Active Tools

O Active Tools for OM GUI Pages:

» Frame A: Browser “Find in this Page (Ctrl+F)” search tool:

— The browser search menu option features keyword search of the data within the
current screen (page) display.

» Frame B: OM GUI navigation tool:

— Features ability to review previous/next page or to reload current page show on the
OM GUI.

= Frame C: OM GUI AutoRefresh tool:

— The AutoRefresh Control Panel, displayed at bottom of most OM GUI pages, can be
set to automatically reload an active page by designated minutes.

s*Figure: Find (A), Navigation (B) and AutoRefresh (C) Tools

AR el |8 et @ previous (1 Hoviorean [ matcheme
B ’ :
naVIQatlon C first | previous | Showing 1 -5 of 405 | next | last
Preavious Page - Naxt Paga }
;[I( o ) AutoRefresh Control Panel [N ] |
Refresh screen every |5 ¥ minutes
Ralnad AutoRefresh: on O off J

Currant Paga
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Order Manager GUI

Request Management

0 OM GUI - REQUEST MANAGEMENT

» The Operator is provided options to manage, monitor and control
open/completed interventions. Allowing intervention capabilities helps
to ensure eligible requests, from varying order sources, are distributed
or handled appropriately. The action to process subsetting is also
available. Non-fatal errors and warnings related to data space/storage,
ftpPush/SCP destination, and server warnings are functions handled
within the OM GUI.

» Request Management submenus:

— Open Interventions.

— HEG interventions.

— Completed Actions & Interventions.
— Distribution Requests [filter].

— Processing Service Requests [filter].
— FtpPush/SCP Requests [filter].

— Staging Requests [filter].

— Operator Alerts.

e
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OM GUI

Request Management (cont.)

0 Request Management — Open Interventions

= Provides list of all the currently open Operator interventions that require
action. Interventions can be managed using a Change Filter, Bulk Fail
and/or Bulk Submit features on the page.
» Interventions activities performed to:
— Select a different granule to replace an unavailable granule.

— Fail selected granule(s). [NOTE: A permanent action that cannot be canceled
after confirm action.]

— Change the attributes (distribution medium, disable limit checking, update
parameters and [.XML] to [.ODL] format conversion) for a request.

— Attributes changes to update FtﬁPush/S_CP parameters option will edit the existing
(related) FtpPush information when the intervention is closed.

— Change the disposition: Resubmit, Fail, or Partition (divide) a request.
» Failing a granule is a permanent action, if confirmed, cannot be canceled.

= Standard media capability limits for a particular media type (i.e., FtpPush,
FtpPull, SCP) can be override, using the Disable Limit Checking
attributes options.

= The Reset button on pa%e_s, it simply resets the Request Level
Disposition options to their original value.

e
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OM GUI

Request Management (cont.)

1 Request Management — Open Interventions

» Open Interventions Page has three working parts:
1 — Current Filter (Frame 1) — pre-defined filter criteria.
2 — Options (Frame 2) — features to change filter, bulk fail or bulk submit requests.
3 — Listing (Frame 3) — requested distribution filtered output.

Current Filters Options Listing

Fiolds Actions Fialds
ardar (D Change Filter Sal
OFail O%ub
Craation Time: Bulk Fail
Pt s Crdaer (D
* End E
: Hane Reguest 1D
Modial Typa Bulk Submit
: *All Madia Typa
Intervention Typa * Nona

Regquast SEa

Request ID (MD)

Worked By SEaks

Explanation Worked By
Creatad

Acknowladgad

Explanationis)

IntareType
[
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OM GUI

Request Management (cont.)

1 Request Management — Open Interventions

» Procedure: Viewing/Responding to Open Interventions
> Click Request Management menu, then click submenu Open Interventions.
> Specify the Show <number> rows at a time display: Under Listing, select 20.
> Organize/Sort page by creation time, in ascending order: Click Created label.
> Display detailed data of order: Click a specified Order ID <number>.
> View Open Interventions For Request <ID> details: Click a specified Reguest ID <number>.
>

Assign a Worker: Click the assign link and enter <employeelD> in input box, then click the
green-checked button to confirm.

s Figure: Worker Assignment

Worked by: . .. woersssignea - [ assign ] jpino @ [=]

> Manually Fail Granule: Under Granule List section, Locate Explanation, “Manual fail required”
and click Fail checkbox, then click Submit Actions button.

> Change granule attributes to alter the characterization or features, under Request Attributes
section, click Change Media to arrow and choose new type; click Change Priority to arrow and
select new priority; click Disable limit checking checkbox to disable size limit.

|
625-EMD-204 Interim Update 1 — LaRC 7.21 22



OM GUI

Request Management (cont.)

0 Request Management — Open Interventions

» Procedure: Viewing/Responding to Open Interventions (cont.)
ssFigure: Worker Assignment A

FtpPFull

Change Priority to: FipPush
v / COROM

If SCP (DD or DLT), cannet {ﬂ Disable limit Shesking bLT

Request Attributes fgdia List:

: ; s DwD
change madia type; update s
SCF Paramatars availabla (but & Change XML to ODL = Al /
[ ] Update SCP Parameters T / Request Attributes
'!-.l e —

noupdates to DVD or DLT)

If NOT SCP (but IS FtpPush, FtpRull or Change Me b Change Priority to:
COROM) option available to changs - IF e A h'd
mediatype; noupdate SCF (FtpPull or A . fitmas oL
COROM) Paramaters, can Update D Disable limit checking ' 8 F"rinri:yList:
Sl (] Change XML to ODL Low
: Mormal ==
High =
¥High
XPress

> Change Request Disposition: Click Fail Request option, then click Apply to commit changes.
ssFigure: Request Level Disposition
| Request Level Disposition |

& Keep on hold
) Submit

O Fail Request
O Partition [ Interval: day(s) and | hours |

> Close the Close Interventions page, as appropriate by entering Additional e-mail text, if sending
e-mail message to the requester or click Don’t send e-mail checkbox, then click OK.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Request Management (cont.)

1 Request Management — Open Interventions
ssFigure: Open Interventions Page
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OM GUI

Request Management (cont.)

1 Request Management — Open Interventions
ssFigure: Interventions For Request <ID> Page

Iréervention For Request 0300082129

Ordesr |0: ERO00SZATY User ID: labugsr (abusendieos hite com)
Requast |0: (300083120 Crasted; Apr 17 2007 11:044M
Input Size: 110 esimated MB Ackncededged:
edia Type: S0 Request Satus: Operator Inteniention
Friorify: VHIGH Matudatn Format: XML

Explanation{g] Transfet failad
Warked by: - @0 wodker azsigred - [ asmian |

Granule List

o diactytorom] | % [ ot 4 com Show | 20 | powes at a tima,
Hiot| sisvious| Shewing 1-1 811 | ned | last

| DFLID 3 I Size [MB] | Oub Size (MB] | Stelus
B - | 167831 AST_LIBOO3 SC 118753 AL e sy Pl
Select all I—
Submit Ackicns

fird | prawious | Shewdng 1- 1 of 1 | pad | st

Request Altritues | Regquesi Lavel Disposition
Changs Pricrity to:
T :‘I i« Keap on hald
" Submit
L Fail Raques
" pariion [lnlqrul:l_di'ﬁl} and |_hwm]

I- Dizakle Nmil cheding
[ Changa XML fo ODL
r. Updats SCF Paamstars

Cperafor Noles
0 of 255 ma chaiactu

NOTE: Update FtpPush/SCP parameters option,
edits the existing FtpPush information when the
intervention is closed. Option appears on
confirmation page for FtpPush/SCP media types)

sopty | rese |
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OM GUI

Request Management (cont.)

1 Request Management — Open Interventions
s*Figure: Close Confirmation for Intervention (FtpPush/SCP changed to CDROM)

B CLOSE CONFIRMATION FOR INTERVENTION 5501428

- Operator Notes |

0 0f 255 max characters

You are about to coss this intorvention. close

If disposition to Keap

The fellewing acticns will be taken:

on hold, ragqueast-laval

attibutes are rejectad Compara "Dispostion” confirmations: _ . - Disposition | Limit Checking Dissbled | New Media | Hew Priority |
and Operator Notes *Bubmit to close intarvention (A closa) _ submt | na | comom | woH ||
saved Apply f rsat | | "Ke0ponholdintarvantion (A hold)

| u_.‘"- IRHPORTANT - Since you are changing the media type from an electronic 1o a phyrsical type (COROM), pleasae fll in or update the
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- ] e
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0 r _""a
hold | s ars ket i place this Infenmstion on kel ] =" i Addrews 3 St 108 If phrysical media changad
'LL.um—J_ Waming and peT Tl
K. LI AL Do N L a Impurtr:ﬂ.ﬁ.larts %-t:m o update orfilkin information
i Sl *_'.-' - mwmmmdmmm shipping label , a5 requirad.
~ e W Wil Ly Country 154
TR, P CHew  f ZipPostal Code 207300
ey Medla Pduity  MatadataFormay “Raguined Sold
WARIING: Snce you ars plicng thit infermntion on hald, nona of the Are you suro you want to take the actionis) listed above?
wﬂl«: wn ¥ selacted will be spphed - ondy the oparalor #C3cking the Cancel butten will bring you back 1o the intervention Page for this intervention i}
—o%_|_cancel |
Ae you wiine you wanl 16 take the scionil listed abova?
(Chcking the Cancel bution wall Bring you back 1o the istervontion Page for this inbervention 109 I
0K | comcut| INTERVENTION PLACED ON HOLD
Intervention 4502105 has beaen placed on hold. The OM Database has been updated with the changes.
C x|
confirmed
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OM GUI

Request Management (cont.)

1 Request Management — HEG Interventions

» HEG Interventions processing involve “line items” and associated
detailed links. HEG orders contain a mix of granule types. The Open
HEG Interventions page provides Operator the capability to:

— Assign/Change Worker.
— Fail selected granule(s).

. 1 2 s
— Fail a request. . Current Filters

— Change request’s disposition level. il sl el
. ordariD i Sal
= Open Interventions Page has three il Sheng AT oFoa Dot
working parts: S BulkFail OrdariD
* End ot
1 — Current Filter — pre-defined filter T Bum“a'jbmit Raquest ID
criteria. Requast ID Dﬁ" Meadia Type
O Mona
2 — Options — features to change filter, kel B REGEst e
bulk fail or bulk submit requests. _
o . . . Explanation Status
3 — Listing — requested distribution ——
filtered output.
Croatad
Acknowladged

Explanation(s)
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OM GUI

Request Management (cont.)

O Request Management — HEG Interventions

» Procedure: Viewing/Responding to Open Interventions
> Click Request Management menu, then click submenu HEG Interventions.
> Specify the Show <number> rows at a time display: Under Listing, select 20.

> View open HEG Interventions For Request <ID> details: Click a specified Request 1D
<number>.

> Assign a Worker: Click the assign link and enter <employeelD> in input box, then click the
green-checked button to confirm.

> View processing instructions detailed data related to a granule ID, click [View...] link, under the

Processing Instructions column heading in the Input Granule List section of the details page.

Click the red, X-close window link, returns to open HEG Interventions For <Request ID> page.

ssFigure: Processing Instructions for Request <ID> Window
 —|Processing Instructions for Request 1D 08000132332ECS Granule 1D 121960:DPL Granule 1D 36718 - M-l

¥ to closs view 5 eiase windaw Fontagze; - | _nomal | - |50t (g

| Increasa (-] or Decraasa (+) text

<?xml version="1.0" encoding="UTF-§" standalone="yes"?> &
<request xmlns="http://newsroom.gsfc.nasa. gov/sdpteclkit/toolkit heml™>

<requestInfo>

<clientName>WebAocess</clientHame>
XML process <metaflag>true</metaflag>
instructions is <gummaryFlag=true</summaryFlag>
</requestInfo>
roadionly. <1npgtf'lles'>
<fila>

" <fileNama>/datapool/T52/uger //F51/MOAN/MOD2Y . 0042004 .01, 06/ /MOD23 ., AZ00400¢
</fila>
e </inputFiles> . _'I:I
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OM GUI

Request Management (cont.)

O Request Management — HEG Interventions

» Procedure: Viewing/Responding to Open Interventions

> To Fail Action(s) on request(s): Under Input Granule List section, select the Fail or Select all
(bulk fail) checkbox under the Action column section. Select one or more Request Level
Disposition options. Enter Operator Notes. Click Apply to commit/submit action, then click OK

button to confirm closure of the Intervention(s).
s*Figure: Close Confirmation For Intervention <ID> Page

You aie sbewl 1o tlaws this intereensise.

The lullrwing sttions will be laken:

 Opeiton | US| e | v |
Fesubera ':::u I = |

PLEASE HOTE: Ary gramsles marked "Laled by cperator” wil sttwrmpl 10|
bt reprocessad Fibis b nol whl you wested, go back snd sebict ihe
“Hubmid” & whach wil iy mesmcve wny laded by
operalne” gramdes fom the regues

Adw i suie you wast 1o Leks the actionf) Thted above?
[Chthatsg the Caneed buition sl Bivg pou bick |0 the ireerentan Fage lee this sfesmtian I0)

EI(IEHI

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

___________________________________________________________________________________________________________________________________________________________|
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OM GUI

Request Management (cont.)

O Request Management — HEG Interventions

s*Figure: Open HEG Interventions Page

Opan HEG Interventions.
Carrent Filters
Order B More Pequest il Mere  Worked By Nore
Enmnil: Chwc 7 2007
Crosien Tamat mmtmmmmm
Bbedis Type:

Enplamatione & chee Hooll Cafnol be Fesached, Coliect biecis For QG Faled) ' aldaton Of Confgured Destreton,
Fasbeed bry Cpernbor,  mindd brarinerring, Fie not Sound i &echeve, Fin nat ound n e, Fip Logn Brors,

Fiush Deaciory deet rof Evist or Mo Weile Permission, Oranule ecceeds Boda capaoly, Granuis fsled stagrg,

g Frocessing Ericr, Heg Processing Ermor, invald Host Address, ivalkd Pasrword, vald UROGrsnuis Mot Found,
s Feiry Fipac P, haoe Fontry Fieactnd, Man B sl tor Fip Push Encended, Madmum Grarue Count Eoeeded,
sy Craat Ervr | ek Creation. Ropped, Requent Resutsniied, Psgurs nutperded by Operator,

Ryt sunpended by Sarver, Trarater faled, Wisting For device sasgrment

Optians
o Buk Fail | Bulk Sy |
LI Clan Clnone CJan Clnone
Ciick on & mcuesd 10 10 vebw moss delisls
Listing
-}.m--l _;*__]-'4— them| 50 ¥ omwatma

!ﬂlm!mwi 4 ofd | pont | lapt
it QM Regsen Medape BT Sum  wonedoy

Explamatien: Archee Host Cannot be Reached,
Cofect Media For OC,

Faded Vabdatsan OF Confgured Deslnabion,
Faded by Operator, Failed transfemng,

File mot foursd in Aschive, Fie not found in Archive,
Fip Login Emots,

FipPusch Deectory does not Evist or No Witte Permission,

Granube svcaeds mbdia capacty, Grands lied stageg,
Heg Processing Emor, Heg Processing Emor,

Imalied Host Address, kewald Pasrwond,

Inwalid URGranule Mot Found, Max Retry Reached,
Max Retry Roached,

Max time allowed ke Fip Push Excesded,

Maximuen Granule Count Exceeded,

Media Creation Emor, Madia Creation Stopped,

Riequest Resubmitied, Request suspended h] Operator,
Request suspended by Server, Transfer fuled

Wisting Fer dmwce s sigembnt

Ll pE0o0000E? EOO0OgS1|  FpPull 30 PENDING | Sep7 2006 1.58PM Heg Processing Emor
O 0O | peooonoies QECOOO0caD FipPull 53 PENDING | Sep7 20E310PM Hieg Processing Eror

Heg Procesaing Emror
O 0O oot Soa: FrpPul I PENDING Sep 11 2006 304PM Duplicate Req. b
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OM GUI

Request Management (cont.)

O Request Management — HEG Interventions

s*Figure: Open HEG Interventions For Request <ID> Details Page and its Table (Fields and

Actions).
intervention For Arquent 080001 9
Crdur 10 DRI 46 U MO0 £ St (it Evs €E 0 Al ) - .
Requst I 2000107 53 Cranizd: Agr S 2005 E0SPM Intervention For Input (_Eranule Re[_]uest_l__evel
Input Sire: 27 estimated LE) 1 Request <n> List Disposition
Mpdia Type; COR00Y Rirquest Status: Dpersrae Inpeaemien ) : :
Priority: NOFRAAL Fialds Fields Actions
Esplanation(y ) Heg Proceveng Eroe
Wered by - oo vorter sangred - | agn | Cirder D Granula D OKesp on hold
b Raguast (O DPL ID OSubmit
Tia ey b v O | gt 2 et ol -0 %) e i :
| Input Siza ESDT OResubmit and
; rm.u{.qzqrrmw . rgtryj processing
FEL ] Al MOOZS00H  5C [ Ve | 18272 FalLen Mg - Errae Fell Media Type Typa of failed granules
AZEBEt  maps MOOZHD0M ST [ Wi | 1157 waod STAGED - — SR OF ail Request
= . Instructions Operatar Notas
e Aty Explanation(s) [ifiaw...] ?in Ut fiald)
o | | Beowing 1 - 1o/ T | oo | — P
. — Waorked by [assign] n Size (MB) Apply
= ewp o hoid Status
- UserID rasat
;?'“_ mﬂmmi“ﬂm . Creatad Explanation
Operator Neley | Action
O of 7% mEx characiens Acknowladge OFail
D% alact all
Submit Actions
Submit Actions
]
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OM GUI

Request Management (cont.)

0 Request Management — Completed Operator Actions and Interventions

» Displays all recently closed interventions, including those that have
been resubmitted, partitioned or failed. By default, the interventions are
filtered by “completion time,” within the last 24 hours.

» Operator defined filtered results displays on page as described

in this table: | 2
. Filter . filter display

Options Fields
Intarvantion Typa: Ordar|d
OAll
Ebans Reguast Id
¥ Intervention Types :
=Activare Media for GIC Hearif
=Activiae Request "
"Azemble Padage iz (ME)
"Collect Media for GIC Madisa
®Digmount stedial from Production
"HE Bror
=iedia Credfion Ermor MDrkadl By
=Mount Medial for Production ;
S Intervantion Typa
"Operator Inerwention
*QIC Failed Crasied
Warkad By Completed
Complaetion Tima: Dizpogition
OApply
OR&m at
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OM GUI

Request Management (cont.)

0 Request Management — Completed Operator Actions and Interventions

» Procedure: Viewing/Filtering Completed Operator Actions and Interventions
» Click Request Management menu, then click submenu Completed Actions and Interventions.
ssFigure: Completed Operator Actions and Interventions

Completed Operator Actions and Interventions
Filter

intervention Type: [ainiosbisiig o Starl Morth Staet Ciay Start Yesr Start Hour Starl Minuts
Jma]| Nore | g;.“:,}.;ﬁ.':..k;;,. Completion 01 % 21 % 2008 % 10 » 35
e Time:
EndMonth ErdDay Erd Yes EndHou EndMirde I
Worked Byz | ALL v 2 Mty vl Bl Yol . Sl Wit | seprpral v

o disactly ta row 0k | 020 pows shmi;—&] R e

WRRIF | P vl 10 REvigtel

firzt | previous | Showing 0 - 0 of 0 | ned | last

Orderld | Requestld | UserlD  Size (MB)  Media  Worked By  Imervemtion Type  Created  Completed  Disposition
first | previous | Showing 0 - 0 of 0 | nead | last |

> Specify the Show <number> rows at a time display: Under Filter, select 20.

> To define the filter criteria: Under the Filter section, select one or more Intervention
Type; select an available User or All Users from the Worked By list box, then define the
Completion Time (the start to end times). Finally, click the Apply button to apply the filter.

» The Completed Operator Actions and Interventions page refreshes with the filtered results.

> To display detailed information of a request, click a Request Id <number> link in the
list to display the Completed Operator Action For Request <ID> page.

e
625-EMD-204 Interim Update 1 — LaRC 7.21 33



OM GUI

Request Management (cont.) %

0 Request Management — Completed Operator Actions and Interventions

» Procedure: Viewing/Filtering Completed Operator Actions and Interventions

> To view Processing Instructions (details) related to a granule ID: Click the View... link,
under Processing Instructions column heading in the Granule List section
of page. Click the red-X close window text to return to the Completed Operator

Action For Request <ID> page.
ssFigure: Completed Operator Action For Request <ID> Page

: COMPLETED OPERATOR ACTION FOR REQUEST 0300004074
Userld: ECSGuest emall: oladele_ogunsuvig@raytheon com  Prierity: NORMAL
Orderid | fiEe [ Media | Workse lnhriritllhﬂTmJ Created 1Wu Disposition | Explanation
& | | Activate Media for|  Apr 15 2005 i Request! Waiting For device
LU s EOROM) ac 1 48PM Aclvated| assignmant
i —— GranueList |
G-nuletuylnmf ! Efurzrm |Sn|:m' 20 | rows at & e |
first | provious | Showing 1- 2 of 2 | nest | last ' |
DEID | mr.' ] Size (MB) l Status Processing Instructions | Explanation |
21221 MO 342 004 [
bFL Grando 0 1432 | S o1 stacen - | |
EL{’;M s | M‘:'D’W“SDEJ_ 30.3a-a| STAGED| Wik View... links to the
e e = = = = A .
firet | previous | Showing 1- 2 of 2 | nesd | lasl granule processing
instructions window.

OPERATOR NOTES

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
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OM GUI

Request Management (cont.)

U Request Management — Distribution Requests [filter]

» The Distribution Request page allows Operators (either full-capability or
limited-capability) the ability to filter and view lists of all currently
distributed requests processed through Order Manager from all order
sources. The data distribution functions eligible on requests:

— Suspend new request processing.
— Suspend or cancel individual requests.
— Change the priority of any request.

» |n addition to these capabilities, the Operator can view extensive details of
FTP Push distribution and staging requests by selecting order id or
request id column links.

= OM GUI pages are tracked with a Session ID, which provides the Operator
quick access to filter options used during a particular session:

- For example, an individual Operator’s previously defined filter criteria can be retrieved
from the Session data so the filter criteria do not have to be redefined every time.
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OM GUI

Request Management (cont.)

O Request Management — Distribution Requests [filter]
» Open Interventions Page has three working parts:
1 — Current Filter (Frame 1) — pre-defined filter criteria.

2 — Options (Frame 2) — change filter, bulk cancel (All or None), bulk resume.
3 — Listing (Frame 3) — captures requested distributions filtered output.

Current Filters Options Listing

Display Optionz Field=
OrderiD Changa Filter Sal
Creation Timea: Eiulk Cancal Ord Typ

Gtart (dats &tima) O5alazt All
End idate & tim a) O Salact Mona GrderlD
Madia Typa Bulk Resumea Reguastid
Ofalaczt All :
Osalact Nona Requast Sza (ME)
Raguast ID
Gran Gnt
E-Mail
Moedia
Statls Priority
First Nama Request Status
Last Nama ESDT
Qrder Typa UserlD
Resub Cnt
Usar D
Creatad
Last Updata
Actions
OR = ubmit
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OM GUI

Request Management (cont.)

O Request Management — Distribution Requests [filter]

» Procedure: Viewing/Filtering Distribution Requests Data
» Click Request Management menu, then click submenu Distribution Requests [filter].

> To perform a specific action (suspend, resume, cancel resubmit or stop a distribution request) on
a distribution request from the Actions column options, on the page:

> Click the appropriate Action button associated with the request (or the appropriate button
in the Action row on the Distribution Request Detail page), then click the applicable
response from the associated actions dialog box.

> To define the filter criteria: Under the Options section, click the Change Filter button to display
two filter criteria sections for Individual or Combined Filters. Then create a combined filter as
follows:

> Select a Start Time and End Time.
> Make multiple Status Select selections using the <Ctrl> key.
> Select All for Media Type Select.
> Select HEG for Order Type Select, then click Apply Combined Filters button.
» The Distribution Requests Filters window closes and displays the Distribution Requests results.
> To display profile information for a request, click ECSGuest under the UserID column.
* The PROFILE FOR ECSGuest Order ID <ID> window displays six information parts.
> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
625-EMD-204 Interim Update 1 — LaRC 7.21 37



OM GUI

Request Management (cont.)

O Request Management — Distribution Requests [filter]
s*Figure: Distribution Requests Page and Filter Window

A hawribotion Requests
Cument Fiken
Drdar B W [LCT R Y (T il Mo Mg Lokl B Fiose
Crowson Tamae: Siart Now 17 2007 02-pEaw I Jam 39 3008 114080 Drdar Ty HEG Hnor Kk Nora
¥ = > Parwri bt pd & £
Distribution Miska Eyper Batun L
Requast paga (i
working sactions. Bk Cancel | Bolk B |
[ sateet A8 [ 3alect Mane

Listing
hi-elﬂ---l ._I-u-i-u W vt o
firat | pewmtcuy | Showing 1 - 3 of 6| st | lawt
RomostiD dsploy= s 22 I ae oy R e T o R e
1. Distribution Request <I0*> Data =i ; o o T T a0 | w17 20081
2. Reguest Notes (T 2040 characters) s _,,,a._.__iﬁ'b'ﬂh'-'-*' i Swpped | MODUAZOOH (ECSGm I | ogg ™ | aw | it |
S.F'ru:ufilalnfnrrnatinn_ : L HEG e 1 Pl MODTIAZ 004 |ECSGues 2 JTW JTW Rsscen |
4. Reqguest Granules information: mmf‘“ B« - -
a)DEID Ll HEG |ngscmiees| 0 | 1 (FPu "'m'l‘““““'
bBIESOT Typa ol bes M “ ; [nomiar = Filters
c)Processing Instructions BO0CISET s e | oy ST I:':_.“ i
Of v | MBS @ |1 [rea) | 2 . i
PP R - o Indi'l.ril_:luall:ur
EEROgATS | _ FrgPu I irtg Combined Filters combinad
E00001853 | [y Pspiem Covion P Pl filtaring
] [ =i et T e S e capahility.
U*Eﬁi%“r’g I P |
Auesstatrath Cosiral Panel [0 ] Narmal e . e T S
Flofrwsh aceean poery| & st High e
Busciuk: Clon Clofl VHigh A s -
XPross ==
—_— Fams

= By | o |
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OM GUI

Request Management (cont.)

O Request Management — Distribution Requests [filter]
ssFigure: Distribution Requests Actions Response Dialog Boxes

[JavaScript Application]

i,’: [Buspend|Request 0400081320
-

&n intervention will be created [JavaScript Application]
Suspend Distribulion

Request dialog box @ Are you sure you want to[create an intervention|
and [submitthis Request 04000649227

Resubmit Dishribulion

Request dialogbox | (K Cancel I
ConfirmResumelfor | ——y

Request ID 0400081320 [=| Netscape

_Wurker

Reason for Adtion h?nﬁ:uﬁ:i:n:e e Confirm _[g: I : IE! I for 1
Request ID 0400081320

Worker

| Cancel Dishibvlion Request
Apply "Resume” Action| Cancel "Resume” Action | Reason for Action Confimation dialog box

Apply "Cancel” Action| Cancel “Cancel" Action
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OM GUI

Request Management (cont.)

O Request Management — Distribution Requests [filter]
s*Figure: PROFILE FOR ECSGuest Orderid <ID>

PROFILE FOR EC SGuast Cuderld 0800001509

ACT INFORMATION LACCOUMT IMFORMATION
Py =
2 o iF Pams Date croahed: = o
o5 Msil addross: Faye £_Pamiaythen com Expiration date: 5 'EI'
a 3 ration: Friviliege laval: o E
o Werification Hey: (PR, g L
o O Acoees privilege: E B
g r+ QPmject | : =
3 i1 o
aiws o Sudy: i
DAR IHFORBMATION
Sag: 5
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[ i or @
[ M | o E
T ﬁ' avince: 55
w
L £
‘wlephane: 12345575
5 BLLIRG ADDRESS
|nuc
% Flrat Hasna;
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Drganization: L=
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TipTraakal casdhe
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OM GUI

Request Management (cont.)

1 Request Management — Processing Service Requests [filter]

» The Processing Service Requests page allows Operators (either full-
capability or limited-capability) the ability to cancel or suspend the
external processing requests still under OMS control. Although,
requests under the external system can not be canceled or suspended
by the Operator.

» Processing Services Filter includes options to filter on external
processing service (external subsetter requests) or HEG in addition to
other selections.

|
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OM GUI

Request Management (cont.)

U Request Management — Processing Service Requests [filter]

» Procedure: Filtering Processing Service Requests
> Click Request Management menu, then submenu Processing Service Requests [filter].
> To define a combined filter criteria:

> Under the Options section, click the Change Filter button to display the Processing
Service Requests Filters window.

> Under the Combined Filter section of the filter, select criteria:
» Request Creation Date (Start Time) = “01 01 2007
» Status Select = All button
* Media Type Select = All button

* Process Service Select = All button

> Click the Apply Combined Filters button, to apply the combined filter criteria and refresh the
Processing Service Requests page.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

|
625-EMD-204 Interim Update 1 — LaRC 7.21 42



OM GUI

Request Management (cont.)

U Request Management — Processing Service Requests [filter]
s*Figure: Processing Services Requests Page (A) and Filter (B)
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OM GUI

Request Management (cont.)

U Request Management — FtpPush/SCP (or Staging) Requests [filter] Page

» Distribution filters allow Operators (either FC or LC) to view extensive
details of FtpPush/SCP and/or Staging distribution requests currently
processed through Order Manager (from all order sources).

» FtpPush/SCP and Staging distribution requests pages allows
Operator the priority of (or suspend) a distribution request
while the to:

- Change requested granules are in a staged (or pushed) waiting state.

- Resume a request that was suspended by the OM GUI Operator or while the
processing of new requests by the OMS is suspended.

- Resubmit a request in a terminal state (e.g., aborted, cancelled, terminated,
or shipped).

- Cancel a request that is not in a terminal state and while the requested
granules are in a staged (or pushed) waiting state.

|
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OM GUI

Request Management (co

nt.)

U Request Management — FtpPush/SCP (or Staging) Requests [filter] Page
» Procedure: Filtering FtpPush/SCP (or Staging) Requests

> Click Request Management menu, then submenu FtpPush/SCP Requests [filter]

(or submenu Staging Distribution

s Figure: FtpPush/SCP Requests gz
page (A) and [filter] options (A1)
and Staging Requests page (B)
and [filter] options (B1)
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Requests [filter]) to display its page.
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OM GUI

Request Management (cont.)

U Request Management — FtpPush/SCP (or Staging) Requests [filter] Page
» Procedure: Filtering FtpPush/SCP (or Staging) Requests (cont.)

> To define a combined filter criteria: Under the Options section of the FtpPush/SCP
(or Staging) Distribution Requests page, click the Change Filter button to display the
distribution requests filter.

ssFigure: FtpPush/SCP (A) and Staqging (B) Distribution Requests Filters.

A| FepPush | SCP Distribution Requests Filters | Staging Distribution Requests Filters |B
Individual Filters Individual Filters
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T T e el o T e g i gl s
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OM GUI

Request Management (cont.)

U Request Management — FtpPush/SCP (or Staging) Requests [filter] Page
» Procedure: Filtering FtpPush/SCP (or Staging) Requests (cont.)

> Under the Combined Filter section of the filter, select criteria:
* Request Creation Date (Start Time) = “01 01 2007
» Status Select = All button
* Media Type Select = All button

* Order Type Select (for Staging) = All button.

> Click the Apply Combined Filters button, to apply the combined filter criteria and
close the FtpPush/SCP (or Staging) Distribution Requests Filters window. The
FtpPush/SCP (or Staging) Distribution Requests Filters page displays with the
applied combined filter results.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

|
625-EMD-204 Interim Update 1 — LaRC 7.21 47



OM GUI

Request Management (cont.)

U Request Management — Operator Alerts

» The Operator Alerts page displays informative non-fatal warnings or
distribution resources errors and will not cause an Operator intervention.

= Alerts clears automatically once error is corrected.
» Operators (both FC or LC) can view four alert types detected by the Order
Manager Server:

1 — FtpPush/SCP Destination Alerts are alerts for destination problems not sufficient
to cause an Operator intervention (i.e., suspended FtpPush/SCP destination).

2 — Data Pool File System Alerts generates warnings regarding malfunctions of the
DPL file system (i.e., server down, no free space).

3 — Archive Server (Quick Server) Alerts detects warnings regarding the Quick
Server malfunctions which suspends the archive server and queues the alerts
display.

4 — ECS Server Alerts (AIM database errors warnings) detects warnings regarding the
AIM malfunctions or OMS resources (i.e., server down).

= The Alerts page has two display parts:
1 — Show <number>rows at a time displays limited records (5 to 100) on page.
2 — Display <list> alerts displays alerts type by group.

|
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OM GUI

Request Management (cont.)

U Request Management — Operator Alerts

» Procedure: Handling Operator Alerts
> Click Request Management menu, then submenu Operator Alerts to display its page.
ssFigure: Operator Alerts Page (A) and Alert Details Page (B-C)
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OM GUI

Request Management (cont.)

U Request Management — Operator Alerts

» Procedure: Handling Operator Alerts (cont.)

> To view email parameters configuration (located at left-bottom of page): Click [Change] link to
display the OMS Server and database Configuration: Email parameters page. After viewing, click
the Previous Page (<) button to return to the Operator Alerts page.

s*Figure: Operator Alerts Page Table (Fields and Options)
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OM GUI

Request Management (cont.)

U Request Management — Operator Alerts
» Procedure: Handling Operator Alerts (cont.)

>

To view all FtpPush requests: Under the Listing section header, select FtpPush from Display
<list> alerts list box.

View the displayed FtpPush listing.

To display extended details affecting the request, select details... associated with the request
under the Alert Info column.

Return to the Order Manager Home page, on left-pane of OM GUI, click the HOME link.
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Order Manager GUI

Destination Monitor

d OM GUI — DESTINATION MONITOR

» The full-capability Operator is provided monitoring capability to
suspend distributions.

= OM Destination Monitor submenu:
— Suspended Destinations.

]
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OM GUI

Destination Monitor (cont.)

O Destination Monitor — Suspended Destinations

= Full-capability Operator views suspended Ftp Push/SCP destinations and
can perform several kinds of actions, with respect to suspended Ftp
Push/SCP destinations from the Suspended Destinations page:

— Resume suspended destinations.
— Suspend active destinations.
— View details of active or suspended destinations.

— In addition, the Operator can perform destination details page actions:

— Change the priority of a distribution request associated with the FtpPush destination
while granules for the request still need to be staged or while granules for the
request still need to be pushed.

— Suspend a request that still needs to be staged or while granules for the request still
need to be pushed.

— Resume a request that was susgended by the OM GUI operator or while the
processing of new requests by the OMS is suspended.

— Cancel a request that is not in a terminal state and while granules for the request still
need to be staged or while granules for the request still need to be pushed.

= The limited-capability Operator is not allowed to change the priority of,
suspend, resume, cancel or resubmit distribution requests.
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OM GUI

Destination Monitor (cont.)

O Destination Monitor — Suspended Destinations

» Procedure: Viewing/Responding to Suspended FTP Push Distribution
Destinations
> Click Destination Monitor menu, then click submenu Suspended Destinations.

> Toresume a suspended destination: Click the Resume button under Resume column (if
applicable).

» The destination is resumed and the Suspended Destinations page list refreshes.

> To suspend an active destination or view destination details of an active or suspended
destination: Enter Destination Name or Host Name (FTP Node) in text fields under Active
Destinations section, then click applicable button (Suspend or View Requests).

* NOTE: Data in the FtpPush Requests List For this Destination section are not in a “terminal” state.

> To view suspended destinations details: Click the Host Name link on the Suspended
Destination Monitor.

» The list of failed destination requests displays in the FtpPush Monitor page.
> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
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OM GUI

Destination Monitor (cont.)

O Destination Monitor — Suspended Destinations

s*Figure: Suspended Destinations Monitor (A) and Ftp Push Monitor-Suspended
Configured Destination (B) Pages
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Order Manager GUI

Archive Data

0 OM GUI — ARCHIVE DATA

» The Operator (whether full-capability or limited capability) is provided
with the option of viewing the repository for all historical distributed
and processed requests on the OM GUI using filters.

= Archive Data submenus:

— Historical Distribution Requests [filter].
— Historical Processing Requests [filter].

e
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Distribution Requests Filter

» Provides atool to view, by filtering the repository of archived distributed
requests information on the OM GUI.

» Historical Distribution Requests Page has three working parts:
1 — Current Filter (Frame 1) — pre-defined filter criteria.
2 — Options (Frame 2) — features to change an individual or combined filter.
3 — Listing (Frame 3) — requested distribution filtered output.

Current Filters Options Listing
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OM GUI

Archive Data (cont.)

=5

O Archive Data — Historical Distribution Requests Filter

» Procedure: Viewing Historical Distribution Requests
> Click Archive Data menu, then click submenu Historical Distribution Requests [filter].
>  Display data in a specific sort order: Click a specified underscored column header.

> Display more detailed data concerning a particular order or request: Click the Order<ID> or
Reqguest <ID> under the identifying column header.

>  Click the navigation Previous Page (<) button and return to the Historical Distribution
Requests [filter] page.

% Figure: Historical Distribution Requests Page (A)
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Distribution Requests Filter

» Procedure: Viewing Historical Distribution Requests (cont.)
> To apply a filter to the Historical Distribution Requests listing, perform the following:
> Click the Change Filter button, in the Options section of the page.
» The Historical Distribution Requests Filters window displays.

> Define filter criteria: Enter search data for any one field of the Individual Filter, then
select multiple options for one or more fields of the Combined Filter. Click the Apply
Combined Filter (or Apply Individual Filter) button to apply the filter criteria and view the
filtered results.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Processing Requests Filter

» Provides atool to identify and filter archived external processing
requests, by external subsetting processor on the OM GUI. Specific
external processing services or HEG requests can be filtered.

» Historical Processing Requests Page has three working parts:

1 — Current Filter (Frame 1) — pre-defined filter criteria.
2 — Options (Frame 2) — features to change an individual or combined filter.
3 — Listing (Frame 3) — requested distribution filtered output.
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Processing Requests Filter

» Procedure: Viewing Historical Processing Requests
> Click Archive Data menu, then submenu Historical Processing Requests [filter].
> Display data in a specific sort order: Click a specified underscored column header.

> Display more detailed data concerning a particular order or request: Click the Order<ID> or
Reqguest <ID> under the identifying column header.

>  Click the navigation Previous Page (<) button, to return to the Historical Processing
Requests [filter] page.

> To apply afilter to the Historical Processing Requests listing, perform the following:
> Click the Change Filter button, in the Options section of the page.
* The Historical Processing Requests Filters window displays.

> Define filter criteria: Enter search data for any one field of the Individual Filter, then select
multiple options for one or more fields of the Combined Filter. Click Apply Combined
Filter (or Apply Individual Filter) button to apply filter criteria and view the filtered
results.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
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OM GUI

Archive Data (cont.)

O Archive Data — Historical Processing Requests Filter

s*Figure: Historical Processing Requests Page (A) and
Historical Processing Requests Filter (B)
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Order Manager GUI

OM Status Pages

d OM GU — OM STATUS PAGES

» The Operator (full or limited capability) is provided summary information
on current requests processing states, with the option of invoking
gueries to view the statuses on the on the OM Status Pages. The status
pages parameters are modifiable using the OM Configuration
Server/Database submenu options.

» [NOTE: Use the Server/Database Configuration menu to set database and server
parameters to "fine tune" the Order Manager Server and the database. These are
general parameters that affect the entire system, but no particular media types.]

= OM Status Pages submenus:

— OM Queue Status.

— HEG Order Status.

— Staging Status:
 Media Type.
 FTP Push Destination.
o SCP Destination.
 Pending HEG Granules.
 DPL File System Status.
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — OM Queue Status

» Full-capability Operator monitors and modifies the current status of
request queues for all media, including for OMS, e-mail, staging and HEG
request queues.

» The limited-capability Operator can only monitor activities of the queue
status page, but cannot change status of queues.

» The OM Queue Status page displays (toggles) in both a graphical Text-
only version (for visually impaired) or a plain-formatted Normal version.

» Both Operators (FC and LC) can determine the status (up or down) of the
Order Manager Server:

— UP (green): OM Server is currently operation.
— DOWN (red): OM Server is not currently operating.

e
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — OM Queue Status
» Procedure: Viewing/Modifying OM Queue Status

> Click OM Status Pages menu, then click submenu OM Queue Status.
> Toggle a different version of page: Click the Text-only version link in upper-right of page.
> Observe the information displayed under Current Request Processing States:

E:] — Green (no letter or A) — the queue is active (or resumed by either Operator or Server
(automatic) intervention).

— Red (no letter or O) — the queue was manually suspended by Operator or if yellow (), that
@ the queue is suspend in progress.

@ — Red (S) — the queue was automatically suspended by OM Server. This is a non-Operator
2 controlled event.

— Red (D) — indicates that the queue has been suspended by Datapool.

> To toggle the queue state: Click on the queue status indicator/button, then click OK button to
confirm the dialog prompt, “Are you sure you want to <state> the <queue type> queue?.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — OM Queue Status

s*Figure: OM Queue Status Page
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — HEG Order Status

» The HEG Order Status page allows the full-capability Operator to monitor
the number of HEG requests and data volume currently in HEG
processing. HEG Order Status page is arranged in as follows:

— Total HEG Requests Queued.
— Total HEG Granules Queued.
— Total Input Data (MB).

» Procedure: Viewing HEG Order Status
> Click OM Status Pages menu, then click submenu HEG Order Status to display its page.
s Figure: HEG Order Status Page (Read-Only)

HEG Order Status
Total HEG Requests  Total HEG Granules Total Input Data
Queued Queued (MB)
0 | 0 | 0.000 _I

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — Staging Status
» Full-capability Operator can monitor the number of granules and data
volume currently in staging states.
» Staging Status pages displays status in ALL or three ways:
1 — Media Type (Frames A).
2 — FTP Push Destination (Frames B).
3 — SCP Destination (Frames C).
» The granules staging information (Figure 15.9-3 Staging Status Pages
and Table (Fields) is arranged in four categories:
1 — Granules Waiting for Staging.
2 — Granules In Staging.
3 — Granules that have been Staged and NOT Shipped.
4 — Granules that have been Staged, Shipped and In DPL.
» The DHWM (Data High Watermark) is the maximum volume of data in

staging or already staged but not yet shipped. If the data volume and
number of requests is above the DHWM, it is assumed the media devices

have plenty of work to keep them busy.
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — Staging Status

= The DLWM (Data Low Watermark) is the minimum volume of data that
should be in staging or already staged, but not yet shipped. If the data
volume is below the DLWM, the media devices may soon become idle.

» DLWM is mainly used for dispatching high-priority work. Therefore, the
amount of work kept in sta%ing or staged below the HWM, of each output
ueue, will achieve a good balance among ftp output connections (or in
the case of physical media, their various output devices).

» Procedure: Viewing Staging Status

» Click OM Status Pages menu, then click one of three staging statuses: Media Type, FTP Push
Destination or SCP Destination. To view another staging status page, select staging type
from the list box on the current page.

> Observe the information displayed under Granule Count and Volume section:

— Staging Status — page display information columns, except data is generated as media or
destination.

— The System Totals — the manually suspended queue by Operator (or if yellow, the
suspended queue is in progress).

— AutoRefresh —if ON, the Stagfing Status by <staging type> page refreshes automatically,
as often as specified in the Refresh screen every <number> minutes.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — Staging Status
s*Figure: Staging Status Pages and its Table (Fields)
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — Pending HEG Granules

» The Pending HEG Granules page allows the full or limited capability
Operator to monitor pending HEG granules.

» Procedure: Viewing Pending HEG Granules

>
>
>

Click OM Status Pages menu, then click submenu Pending HEG Granules to display its page.
Click a specific Request ID under Listing, to view detailed data concerning that request.

To view processing instructions: Click the View... link in the column. Data displays in a separate
Processing Instructions window. View the information in window, then click the Close Window
button to exit window.

To cancel pending HEG granules: Under Options, select Select All (or Sel ) check box of the
specific pending HEG granules, then click Bulk Cancel button to fail granules.

Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

|
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — Pending HEG Granules
s*Figure: Pending HEG Granules Page and Table (Options and Display)
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OM GUI

OM Status Pages (cont.)

O OM Status Pages — DPL File System Status
» The Operator (full or limited capability) to view-only ongoing activities of
the DPL File System Status in two categories:
1 — Data Pool File Systems.
2 — Archive File Systems.

» Procedure: Viewing Data Pool File System Status

> Click OM Status Pages menu, then click submenu DPL File System Status to display its page.
s Figure: DPL F|Ie System Status Page
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> Return to the Order Manager Home page: on left-pane of oM GUI cI|ck the HOME link.
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Order Manager GUI

OM Configuration

d OM GUI — OM CONFIGURATION

» The Operator (FC) is allowed to configure aging rules for each priority
level — Aging Parameter; to set database and server parameters, which
affect the entire system — Server/Database Configuration; and to set and
adjust media types attributes — Media Configuration.

= The Operator (LC) can view the values assigned to OM Configuration
Parameters, but is not allowed to change any parameter values.

= Users can perform validity tests against received granules using
checksum validation on OMS distributed files.

= OM Configuration submenus:
— Aging Parameters.
— Server/Database:
* [All] [queue], [cleanup], [email], [media], [staging], [partition], [misc.], [HEG].
— Media
— Media Creation.
— ODL Metadata Users
— Checksum Users
— External Processing
— FtpPush/SCP Policy
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OM GUI

OM Configuration (cont.)

1 OM Configuration — Aging Parameters

= Aging parameters affect how distribution requests are aged over time.
The Operator (FC) has the option to configure aging parameters (rules)
for each priority level using the Aging Parameters Configuration page.

= There are three types of aging parameters, however only two are
configurable for each ECS Priority Level (i.e., XPRESS, VHIGH, HIGH,
NORMAL or LOW):

1 — Age Step is the aging rate (0-255, including decimal fractions) by which the
requests effective priority increases at hourly intervals, but not to exceed the
“Maximum Priority”. If the Parameter IS set to zero, waiting requests priority never
increases. For example, if the Age Step = 5.5 with an initial priority = 100, waits 10
hours to be pushed, then the request’s priority increases by 5.5 hourly until delivery:

Hour O:priority = 10
Hour 1:priority = 105.5
Hour 2:priority = 111

Hour 10:priority = 155.
2 — Maximum Priority is a request’s maximum priority attained in aging process.
3 — Starting Priority is a non-configurable arbitrary value representing the priority.

e
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OM GUI

OM Configuration (cont.)

O OM Configuration — Aging Parameters
» Procedure: Checking/Modifying Assigned Values of Aging Parameters

> Click OM Configuration menu, then submenu Aging Parameter Configuration
Aging Parameters to display the Aging XPRESS
Parameters Configuration page. Age Step” B
ssFigure: Aging Parameters Page Maximumm Priority * S5
> To modify (as authorized) aging parameter Starting Priority * 255
value(s): type new value(s) in relevant oL
parameter(s) text entry box(es), then click 0 8 1)
Apply button (or Reset button to clear new Mas EXaly = sl
value(s) and retain original value(s). m:::"'“g By i “Starting Priority” valus:
> Return to the Order Manager Home page, Age Step T WHIGH 2255
on left-pane of OM GUI, click the HOME link. Maximuia Bty T ol 2l
Starting Priority 220 LM
NORMAL
Age Step B
Maximum Priority fise
Starting Prionty 150
LOW
Age Step £
Maximum Priority T
Starting Prionity G0
Apply | Reset |

- |
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OM GUI

OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)

» The OMS Server and Database Configuration page provides the full-
capability Operator (limited-capability Operator has limited options) with
options to check and modify OMS server or database parameters values.
These parameters affect the functionality of the OM server and database.

» Parameters are dynamically loaded from the OMS database into the OM
GUI configuration pages. If a configuration parameter is deleted from the
database, it is no longer displayed on the OM GUI - parameters displayed
on the OM GUI are variable.

» OMS Server and Database Configuration Parameters page has four
displays:
1 — Parameter.
2 — Description.
3 — Units.
4 — Value.

|
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OM GUI

OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)
ssFigure: OMS Server and Database Configuration Parameters Types and Names

Parameters (cont) Parameters {cont)

Typa MNama Typa Namea Typa Mama
quens Mum Of Allowead Email Submissions staging Global Staging Status media Due Date for Media Raguest
queus Child Process Time Limit staging Min Moderate Reguast il Global Configured Oparatar
) - - Actions Email
deanvp | Delete Complete Interventions After staging Min BExpensive Regquast
media Ge Timeout
deanup Delata Complate Actions Aftar staging Max Cheap Reguests : ——
media Production Timaout
parfificn Max Requast Granulas staging Max Moderate Raguests e Madia Frep Timeout
parfificn Max Subsat Granulas staging Wi Exypin e Requests media Rimage Order Pull Tima
e Dl Partition mise. Max Failure Archivea i Max Ordar History Days
il Global Configured Email " . )
mist. Max Action Retries i = media Luminex Timeaaowut
cleanup Max Orphan Req Age " i i
Eg Idla Sleap Tima media Media Device Chack Interval
cleanup Cleanup Orphan Req Pariod ; - - -
mise. Action Retry Wait staging Staging Action Retries
amail Forward Dn Email : . -
e Num of Allowe d Yalidations _ staging Btaging Action Ratry Intarval
dleanup Unsuccass Req Rat Time . Fastat Imtaryval
miisc. Action Chack Intarval geeng
HEG Max Mum of Concurrant HEG staging Festat Timeout
mise. Cleanup Chack Intarval Procass
stagin Max Mo Cost Haguasts
mise. Suspand Chack Intarval HEG Max Mum of Concur HEG Proc ang q
ParReg
Max Concument Raqueasts
queue Procasead HEG HEG Process Retry Interval
email Motify Usar for Partition Requasts deanup Cleanup Delay Interval

|
625-EMD-204 Interim Update 1 — LaRC 7.21 78



OM GUI

OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)

» Procedure: Checking/Modifying Assigned Values of OMS Server and
Database Parameters

> Click OM Configuration menu, then submenu [All] under the Server/Database header to
display the OMS Server and Database Configuration: All parameters page. NOTE: This page
displays all categories of parameters listed on the under the Server/Database submenu:

* [All], [queue parms], [cleanup parms], [email parms], [media parms],
[staging parms], [partition parms], [misc. parms], and [HEG parms].

> To modified (as authorized) server or database parameter value(s): Type the new value(s) in
the text entry box(es) for the relevant parameter(s), noting that the new value cannot be 0. Then
click the Apply button (or the Reset button to retain the original value).

« The OMS Server and Database Configuration page refreshes and displays new value(s).
> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

OM Configuration (cont.)

O OM Configuration — Server/Database (Parameters)
s Figure: OMS Server and Database Configuration [All] parameters Page
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OM GUI

OM Configuration (cont.)

O OM Configuration — Media

» The Media Configuration page provides the full-capability Operator the
ability to check and modify media parameters.

» Media parameters, specific to distribution medium type, affects the
limit checking against standard media capacity and the partitioning
of requests.

» The Media Configuration page has two display parts:

1 — Parameter Name — label or title of parameter for each media type:
« FtpPull.
* FtpPush.
: ngFfOM' S~ Dotien
e DVD.
e sSCp. _
2 — Value — parameter size or limit.
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OM GUI

OM Configuration (cont.)

O OM Configuration — Media

» Procedure: Checking/Modifying Assigned Values of Media Parameters
> Click OM Configuration menu, then submenu Media to display the Media Configuration page.

s Figure: Media Configuration Page
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OM GUI

OM Configuration (cont.)

0 OM Configuration — Media

» Procedure: Checking/Modifying Assigned Values of Media Parameters (cont.)
> Observe information on the Media Configuration page, specifically the parameter types:

* MediaCapacity (GB) — initially set to the maximum capacity (in GB) for the type of media,
but should adjusted later to a lower or higher value, depending on data compression usage.

» PartitionGranuleLimit — the maximum number of granules that may be partitioned for the
type of medium.

» PartitionSizeLimit (GB) — the size (in GB) at which point partitioning of a request can occur.

* MinRequestSize (GB) — the minimum number of gigabytes that can be requested for the
type of medium.

* MaxRequestSize (GB) — the maximum total number (GB) that can be requested for that type
of medium, regardless of whether or not it can be partitioned.

* MinBundleSize (GB) — the minimum number of gigabytes in a bundle for the type of media.

* Request High Water Mark — the RHWM is the desired maximum number of requests that
may be in the Staging state, or that have completed Staging but are not yet in a terminal
state (e.g., Shipped).

» Data High Water Mark (MB) — the DHWM is the maximum volume of data in staging or
already staged but not yet shipped. If the data volume and number of requests is above the
DHWAM, it is assumed the media devices have plenty of work to keep them busy.

e
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OM GUI

OM Configuration (cont.)

0 OM Configuration — Media

» Procedure: Checking/Modifying Assigned Values of Media Parameters (cont.)

» Data High Water Mark (MB) — the DHWM is the maximum volume of data in staging or
already staged but not yet shipped. If the data volume and number of requests is above the
DHWM, it is assumed the media devices have plenty of work to keep them busy.

* Request Low Water Mark — the RLWM is the desired minimum number of requests that
may be in the Staging state or that completed staging, but are not in a terminal state (e.g.,
Shipped).

» Data Low Water Mark (MB) — the DLWM is the minimum volume (in MB) of data that should
be in staging or already staged but not yet shipped. If the data volume is below the DLWM,
the media devices may soon become idle.

* Pull Gran Dpl Time (days) [...] — the number of days a granule for an FtpPull request would
normally remain in the Data Pool.

* Pull Gran Dpl Ret Pri (number) [...] — the normal retention priority for a granule for an
FtpPull request.

* Min Pri To Preempt (number) [...] — applies to granules put in the Data Pool for an FtpPull
request.

> To change the media parameter value(s): Type new value(s) in the text entry box(es) for the
relevant parameter(s), then click the Apply button to submit (or the Reset button to retain the
original values).

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
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OM GUI

OM Configuration (cont.)

O OM Configuration — Media Creation

» The Media Creation Configuration page provides the full-capability
Operator with a means of checking and modifying media creation
parameter values.

» Media creation parameters are specific to each kind of distribution
medium and affect whether or not media orders are dispatched
automatically.

» The Media Creation Configuration Page has two columns of information
for each type of distribution media:

1 — Parameter:
» DispatchMode (Manual or Automatic Mode).
 Max number of QC devices per Request (Automatic Mode).
 Max number of Production devices per Request (Automatic Mode).
» Default QC Volume Selection (All or None).

2 — Current value.

e
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OM GUI

OM Configuration (cont.)

O OM Configuration — Media Creation
» Procedure: Checking/Modifying Assigned Values of Media Creation
Parameters

> Click OM Configuration menu, then submenu Media Creation to display the Media Creation
Configuration page.

s*Figure: Media Creation Configuration Page.

Media Creation Configuration

CDROM

DispatchMode | Manual v

Max number of QC devices per Request (Automatic Mode) B
* Default QC Volume Selection | OAll ®None
DLT

DispatchMode Manual b

Max number of Production devices per Request (Automatic Mode) r
_ Max number of QC devices per Request (Automatic Mode) (R |
_ Defaut QC Volume Selection _©Al OMone |
DVD DispatchModa

DispatchModa Options list box
© Max number of QC devices per Request (Automatic Mode)

Default QC Volume Selection

_Apply | _Reset |

> To modify the media creation parameter value(s): Highlight and delete current value, then enter
new value in textbox. Click Apply to change configuration (or Reset to keep original value(s).

> Return to the Order Manager Home page: on left-pane of OM GUI click the HOME link.
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OM GUI

OM Configuration (cont.)

O OM Configuration — ODL Metadata Users

» The ODL Metadata Files Users Configuration page allows the full-
capability Operator to configure a list of Email addresses that signifies
users that will receive metadata in ODL.met file format.

» Limited-capability Operator can only view Metadata File Users
configurations.

e
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OM GUI

OM Configuration (cont.)

O OM Configuration — ODL Metadata Users

» Procedure: Adding/Deleting User Email Address That Will Receive ODL

Metadata File
> Click OM Configuration menu, then submenu ODL metadata Users to display the ODL
Metadata File Users Configuration page.

s*Figure: ODL Metadata File Users Configuration Page.
A ODL Metadata File Users Configuration

ODL Metadata File Users
O | labuser@eos hitc.com
'@ Jon_2_Robinson-Test@Raytheon.com
' Karl_Bugenhagen@raytheon.com
-V_ LaWan_Gamble@ra}dheon.com|
Sharon_Shen@raytheon com B
| Tony_Fu@raytheon.com
dafds@dafd.hie.com
jbaick@eos hitc.com

jnguyen@eos.hitc.com
labuser@eos.hitc.com

Select all
| X
[Lay’wa n_Gamble@raytheon.com | _Add New User I
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OM GUI

OM Configuration (cont.)

O OM Configuration — ODL Metadata Users

» Procedure: Adding/Deleting User Email Address That Will Receive ODL
Metadata File (cont.)

> To Add User Email Address(es) to the ODL Metadata File Users Configuration: enter the new
User’s email address in the textbox (at page bottom), the click the Add New User button. The
prompt indicating “A new user has been added....” appears, click the OK button.

> To Delete User Email Address(es) from the ODL Metadata File Users Configuration: Click one or
more Del checkboxes (or Select all) next to the User(s) to be deleted, then click the Apply
Deletion link. The prompt indicating, “...Delete the selected users?” appears, click the OK button
(or Cancel to discard changes)

> Return to the Order Manager Home page: on left-pane of OM GUI click the HOME link.
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OM GUI

OM Configuration (cont.)

O OM Configuration — Checksum Users

» The Checksum Users Configuration page allows the full-capability
Operator to configure a list of Email addresses of users that will receive a
checksum in the notification email for a request. If Email address for a
Distribution Notice (DN) contain one of these address, the DN will contain
checksum values for each of the distributed files.

» Limited-capability Operator is limited to viewing Checksum Users
configuration only.

» A checksum is a computed value associated with a data file, which can
be used to verify data validity on files distributed by OMS.

» Users can perform data validity tests on the granule files they receive.

e
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OM GUI

OM Configuration (cont.)

O OM Configuration — Checksum Users

» Procedure: Adding/Deleting User Email Address That Will Receive
Checksum File

> Click OM Configuration menu, then submenu Checksum Users to display the Checksum
Notification Users Configuration page.

s*Figure: Checksum Notification Users Configuration Page (Frame A).

Checksum Notification Users Configuration

A

Checksum Notification Users

Del User Email Address

o |Ab-dul G_Khan-NR@raytheon.com

] |Harﬂld Colglazier@raytheon.com

v I Lay'wan_Gamble@raytheon.com |*_-_-_-_-_-_-_-_-_-_-_-__.—_ =

C &EE!I Deletion |Layr wan Gamble@raythean et | I e - - = |
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OM GUI

OM Configuration (cont.)

O OM Configuration — Checksum Users

» Procedure: Adding/Deleting User Email Address That Will Receive
Checksum File (cont.)

> To Add User Email Address(es) to the Checksum Notification Users Configuration: enter the new
User’s email address in the textbox (at page bottom; Frame B), the click the Add New User
button. The new user has been added to the configuration page.

> To Delete User Email Address(es) from the Checksum Notification Users Configuration: Click
one or more Del checkboxes (or Select all) next to the User(s) to be deleted (Frame C), then click
the Apply Deletion link. The User’s email address is removed from the configuration page.

> Return to the Order Manager Home page: on left-pane of OM GUI click the HOME link.

e
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OM GUI

OM Configuration (cont.)

1 OM Configuration — External Processing

» The External Processing Configuration page allows the full-capability
Operator to define and configure the parameters of an external
processing service as follows:

- View the external processing services parameters.
- Delete external processing service with no pending requests.
- Add new external processing service.
- Edit existing processing service configuration.
» The full-capability Operator is limited view-only External Processing
Configurations.
» External Processing Services parameters descriptive listing:
- External Processor Service Name is a unique name for the service.
- End Point URL is the host URL address configured in the ECS registry.
- DN Email Address is the DN email address used by the external processing service.
- Total Requests Queued — is the total number of queued requests.
- Total Granules Queued — is the total number of queued granules.
- Request Acceptance — the acceptance of the request.
I ——
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OM GUI

OM Configuration (cont.)

1 OM Configuration — External Processing

» Procedure: Checking/Modifying External Processing Services
Configurations

> Click OM Configuration menu, then submenu External Processing to display the External
Processing Services Policy Configuration page.

s*Figure: External Processing Services Policy Configuration Page.
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Email address used to send |

F_‘N B py distribution notice

Additional Preamble | Text to include as par of DN

Text prearmble
/ Save | Done | Reset |
A External P ing Palicy C qu
......... Eroceming Senvices
-—-LMMI Pmcssw TN P s i M Dol PR SO R I AN i ORI MO STk s Nt
LI/ Processing | End Paint URL DN Email Address Requests | Granules |, 0000
i Ao L S B Oueued | Quoued | Acceptance
Clj_e | EP1 |123.456.769:1234 | doug_newmang@raytheon com o 0 ACTIVE
C)| e | EP2  |o87.6543211234 Yol 0 0 |acvE
C ] _au EPTest Eﬂelﬂi.hﬂc.cum:mms | prasanna_|_dhudhagiraytheon.com o o ACTIVE
Lie prespthtip:(/tfonii:hitecom: 25401 seye: FTest2 e | hip ¥4ei0) hitc. corn: 18316/sam-cqr binfpoochie | prasanna_|_dhudha@raytheon com| 50 5  |ACTIVE
 Jasman can mot 2
o mmyem-mnda&eudﬂ 3 I e !
g |+ | omHER |
e o0 (00000 8 85  |ACTIVE
— ST |114801 test@raytheon com 1] ] ACTIVE
Delete Selected Processors I
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OM GUI

OM Configuration (cont.)

1 OM Configuration — External Processing

» Procedure: Checking/Modifying External Processing Services
Configurations (cont.)
> To Add a New External Processing Service: Select the Add a New External Processing

Service button (or if editing, the edit button to the associated processing service), click Save to
submit the input, then click Done to return to the previous page.

> To Delete an External Processing Service: Select the checkbox(es) of the External Processing
Service, click the Delete Selected Processors button (at bottom of page), then click the OK
button to confirm deletion (or Cancel to discard the action).

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

OM Configuration (cont.)

0 OM Configuration — FtpPush/SCP Policy

» Provides the full-capability Operator the ability to define, configure and
fine-tune parameter values of FtpPush/SCP destinations.

= Configuration parameters on the FtpPush/SCP Policy Configuration Page

has three working parts:

1 — Global Settings for All Destinations are
parameters that apply to all destinations
(both frequently used and non-configured),
regardless of their individual settings.

2 — Non-Configured Destinations are

FtpPush destinations not specifically Shatk — g
defined as Frequently Used Destinations, o SP Lo wenuel —
but uses the parameter values in the - —— Destiation
. . . . Directory
Settings for Non-Configured Destinations Reset Min. Thronghput =

area.
3 — Frequently Used Destinations are
FtpPush destinations that are non-configured.

s Figure: FtpPush/SCP Policy Destination
Table (Fields)

Global Settings
for All
Destinations?

Fialds

Settings for Hon-Configured
Destinations [Only apply to
FtpPush destination]

Fields

3

Frequently
Used
Destinations

Fialds

FtpPush Max
Oparations

Max. FTF Failures

RHWM

DHWM

DLWM

Max. Oparations

Rotry Intarval

Options

Apply

Rasat

Dastination Name
[Alias)

Dal

Options

Add & Dastination

Dalate Salacted
Destinations

Salact all (Dal)
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OM GUI

OM Configuration (cont.)

0 OM Configuration — FtpPush/SCP Policy

» Procedure: Viewing/Modifying FtpPush/SCP Policy Configuration

> Click OM Configuration menu, then submenu FtpPush/SCP Policy to display the
FtpPush/SCP Policy Configuration page.

ssFigure: FtpPush/SCP Policy Configuration Page (A), Add Destination (B), Delete
Destination (C) and Destination Details (D)

A FtpPush / SCP Policy Configuration|
Global Settings for All Destinations ™ :'Swlor MNen-Configured Destinations [Only apply to FipPush dlmﬂon];
FipPush Max Operations | i i | RHWI| B0 "] Time Out [l 7|
Max. FTP Failures [y i | DHVIL| 5o Tl Min Theoughput i |
SCP Max Operatons o * | owlz —* || Max Opwatwnsp  ° |
Max SCP Failuresls  ° | Retry Mode auemate * | Reyieenaili 7 |
_sowy | s | |

. DelMeciaType  Host Address.  Destination Directory
| [} FigPush origin hite com | Idevdatal/DEVD1/PushiArea

[Vl FigPush | fei01 hic.com dalapacliOP Sluser/F S2/dpadintegration
com:22401 says:  [5R) DL
) e you sire you ant tofdelete the seected destratons? | A-0_bulleriOF
i IdevistatestipPushDic
= Cancel | dewdata/OPS/scpérea
TT=F T | Ampiscp3
[ select all

Add New Destination D
i ¥,

The “Add Now Destinatior?’ snd tha "FTPRush/3CP
Destination Details™ pages display identical fie|ds,
although their funetions serves two differant
Savwe | Resot purposes (frames B and 0
S
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OM GUI

OM Configuration (cont.)

0 OM Configuration — FtpPush/SCP Policy
» Procedure: Viewing/Modifying FtpPush/SCP Policy Configuration (cont.)

> To view details of a destination, click the underscored Destination Name (Alias) and the
FTPPush/SCP Destination Details page (Figure D) displays. View detailed information on
page and click the Done button to close without saving any possible changes.

> To Delete (remove) destination(s) from the Frequently Used Destinations sections: Click
the Del checkbox of corresponding destination(s), then click the Delete Selected Destinations
link (at bottom of section). At the confirmation prompt dialog box (Figure C), click OK to
confirm deletion(s) and move the destination(s) to the non-configured group (and erase its
parameter values).

> To Add a new destination to the Frequently Used Destinations sections: Click the Add New
Destination button to display the Add New Destination window (Figure B), enter values/data to
fields/parameters, then click the Save button to submit and to refresh the FTP Push/SCP Policy
Configuration page (Figure A).

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.

e
625-EMD-204 Interim Update 1 — LaRC 7.21 98



Order Manager GUI

Help

4 OM GUI — HELP

» There are two Help submenu options:

— About HelpOnDemand... which features context-sensitive help for each page,
especially for non-descriptive controls or parameters.

— Help which features text on various OM GUI related topics.
s Figure: Help (A) and HelpOnDemand (B)
Order Manager GUI Help

. . A
= Active search functions i o o v
Hew to tha OMS GUI? Below are some guidehnes an how 1o use this mtedace For complote documentation, see the DID 609 docurment includad wath the installation package for this
ity

u S I n g t h e C u r r e n t W e b Search tip: Having trouble finding a topic or keyword? Use your Browser's search function! In Neiscape, select Edit > “Find in Page " from the menu or press Ctid + F {or AR « F in soma

LMK OS5s) to seanch for taxt withan this page

browser is also o 5
available on pages e

. A W i

H H ST m‘iﬂo&fﬁﬁﬁfmm Page /1, HelpOnDemand is a feature that lets you get context-sensitive help for every page. Anywhere you
Wlt I n t e GUI . Quick-inksto | « 0m Quous Status {2\ see a question mark,simply dlick on it and a description of the control or parameter (and its purpose)
topiconHelp * OM Confiquration will pop up.

paga. * OM Serer Statistics
* OM Log Viewsr
l'."l'l'm is the Order Manager GUI?

Thi Odes Managed GUIis a graphe: al witédface that allows a DAAC operator 10 imanage destibulion fequests made thiough vanous ofder Souwces. It allows the opedator to cieali
“nterventions” on requests which contain problams, causing the orders to be unfulfillable. Examples of such problems would be inaccessible granules, request size too lage, granule too
Tange for the particular media type, elc. The operator can then make a disposstion on the entse request and can even odit or fad particular granules associated with that request

The page at http://f4spl01.hitc.com: 22491 says:

In additicn. the operator may wew detailed informatian on created interventions, distribution requests. and ECS orders, among ather things. Staging queue state can also be moniared, and
the operalor can change the state of processing queues by media type or all media types simultanegushy

The operator may also configure the Order Manager Diatabase and Senver through this GUI. See MMFRSII!—. Context-sensitive
links on Halp

topic within paga.

Do | nead to use a particular browser?
Yes, but you have chesces. Any Mozilla 5.0 based browser can be used with the OMS GUI That 1s because the OMS GUI was built using the DOM standard cumently supported in the
Mazilla 5.0 specification. Mozilla 5 0-based beowsers are

* Metscape T or higher

# Firafax 0.9 or highar

+ Generic “Mozilla™ browsers for Linux or UNIX

We reccomed against using M3 Intemet Explorer due to possible DOM conflicts: and differences in the JavaScript compiles

!
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Order Manager GUI

Physical Media Distribution

d OM GUI — PHYSICAL MEDIA DISTRIBUTION (PMD)

» Allows the Operator to perform media distribution of OM GUI requests.

— Error handling is performed the same way as interventions for distribution requests
are handled.

» Physical Media Distribution submenus:
— Media Creation Console.
— Device Configuration.
— Open Interventions.
— Printer Configuration.
— PM Configuration.
— Reports.
— ESDT Configuration.

e
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OM GUI

Physical Media Distribution (cont.)

L PMD — Media Creation Console
» One interactive console handles various types of media creation actions.
» Media Creation Console has three working parts:

1 — Request Actions: A

_ Media Creation Console I

Ad Request Actions Device Actions A2
° OrdeﬂD irsllgmmslShmm1 50f5|r1m|lasl Show maximum of Ni ~ veluma(s) par requast Apply
umnnn Media Vol ost Due | Action ,_ Media Type. : |
* Request ID | [ Tyoe’ Imﬁ m _Date MO® Type | OPHenE Device g it Tl B EE
. Pending| Jan 25 CDRGM 4
0300084114 e Ml\'m& T 1
* Media Type oaooggzsrs| OLT |1 [ Mecha) 2006 | Reguest ‘ i | Assign to wolumes avatable |onine
[ Pending| [ | FadRecuest CDROM, DVD Al
* \Volume Count 0300084109 | o, | 4 Pﬁmg: ";guff | Activate | Annotste Acten :
0300082368 Prod '11 20PM | .Ruqum {F DiscQC Assign No volumes available | on-line
° | S i E | S - |
RequeSt Status 0300084116 Pending| Jan 28 | Activate . DiscQC2 Clickto activata tha PMD: Assign No volumes avaiable | on-lme
0300082375 | LT | 1| Media | 2008 |anueet £ Reguent = | Device Corfiguration page. | = |
e Due Date | Prod | G:32pM | DiscQC2Sim Assign No volumes avaiable | onfine
| Pending| Jan 28 | |
0300084108 |y + | 4 | ptadia | 2008 (Actvate | Reuest | | UnixDiscQC Assign Mo volumes available | on-line
* Note 0300052367 Prod | 7aapta | |Reavest ||
Action T ' o | e e |'WEU“/ — ofine|
° 0300084119 | f
Ctlon ype 0300082378 | COROM | 1 'l:"::: | ggﬂg:u IRuquest |2 Bincmewt gh hj Assign No volumes avaifable | on-line
° OpthﬂS G ainwaly o row ],!_‘ '_,, s ols e klui . e = avaljable .on-lme
. . first | previous | Showing 1-5 of 5 | next |last 3, CDROM status. :
2 - DeVI Ce ACtI O nS A 20 fg Assign No volumes avaifable | on-ling
. . 3 Fiter ST | | oy =
Activale lbedia for GC — — ]
® MEdIa Type Device Action (T You must select at least one Action Type | |mDLT2 /Et Assign[o3cocezaravoLosr  ~ | [ mlgn[n:wmitsmnn-th
27 - Bl Assembie Package Selact: Ap tone | Apply

* Production
° QC
« Status
3 — Filter
» Action Type

Calect Madia For OC

Clickto changs the
spacified voluma of
the salectad devica
to Assign or to Mount.

Assigned 0300082374 VOLOO1
[1 Mount 0300082374 VOL0OO1

[ Assign | 0300082143 VOLOD | on-ime|

| BUSY Mode DEVDS

[ Assign | 0300082143 voLoa | on- Ime

_5IM1; [ Assign[caooce2azivoLoel v |
| DLT_SIM3 BUSY Mode DEVOS

[ Assign|e3ooceza7s voLoot

[J Assign [03c0082274 VOL0O1 ';,‘

| nn-lme
DLTSIM1

DLTSIM2

Dismount Confirm dismount of the specified volume from this device
Click Dismount to fail dismount
Assign Assign a volume to this device
Mount Confirm mount of the specified volume on this device
Click Mount to fail mount

Legend
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OM GUI

Physical Media Distribution (cont.)

L PMD — Media Creation Console
» Manually dispatched PD media must be activated using the console.

» OMS production software (EcOmPdModule) runs twice during media
production:
1 — for Media Preparation.

2 — for Media Creation.

= Additional activities occur for disk and tape preparation and creation as
displayed in table:

Preparation Activities Creation Activities QC/Verification Activities
Dizsk (CD/DW D) Disk (COOWD) Disk (CD/OW D) and Taps (DLT)
HOF and matadata fila are read Merga (labal data) file is creatad Tha madium is insarted in a differant drive
Data is stagad Luminax intarfacas fila is crastad ttggno}h;tsE:?:ﬁf;:ﬁiﬂf;;??&éagg,
Summary fila is crested Luminex writes data to media The operator starts QC from the OM GUI
Summary fileis copied Jewel casainsart is printed QC compares the summary fila and the
Jowal caza insert is creatad 180 image and interface file are cleanad up Aaretiitape o st disa e redicm
130 imagefile is created Staging directory is cleanad up
Tapa (DLT) Tape (OLT)
HOF and metadata file are read Data writtan to tape
Dats is staged Tape labelis printad
Summary fila is created Staging directory cleanad up

Summany file is copiad

Tapa lzbal is creatad
|
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OM GUI

Physical Media Distribution (cont.)

J PMD — Media Creation Console

» Media creation has four basic actions (process order):
1 — Activate Request
2 — Collection Media for QC
3 — Activate Media for QC

4 — Assemble Package

% Figure: Media Creation Console basic process display by column: Request Status (1),
Action Type (2), Options (3)

Media Creation Console

Request Status Action Type Options

Raad-Cnly Raad-Cnly Listhox
Panding Madia Production 1. Activata Request Activate Requast
Perform Device Actiore [right-pane Media Creation Corecke): Assign Waolume =] Assigned
Transferring I 2. Collection Madia for QC Madiz Collection Complata
=G Hold . Activate Media for QC Activate QC

Perform Device Acfiors [right4pane Media Creation Corcole): Aszsign Wolume (2] Assigned

Whaiting for 2hipmeant I 4 Assambla Packaga I Mark Request Shippad

Marked Pequest mowved to Disvibution Request page.

+* NOTE: Additional actions (options) are available, but will not be covered in these procedures.
e e
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OM GUI

Physical Media Distribution (cont.)

O PMD — Media Creation Console

» Procedure: Using the PMD Media Creation Console

> Click Physical Media Distribution, then submenu Media Creation Actions to display the Media
Creation Console page. Use the console to process a request using four basic actions:

> 1st Activate Request: Using the Filter (A3) to filter all options labeled Activate Request. (If
none listed, change Option on a DLT media type). Under Options, select Activate Request
from list. The Request for RequestID <number> (media_type) prompts, click Activate Request
to move request to right-pane Device Actions for action. Locate request associated with a
Media Type Device, then click Assign checkbox to assign volume (B) to the device.

:22401 - Action: Ac.... (< |[B])

Activata Request
OLT
LT est for RequestiD
0300082367 (DLT)
== Sample data
Volume i T roduction
: o i MWome | Staws ~ Module
Volume Name | Volume Status | Proc  voLooi | NONE MODISOUT
| vowm | NONE MODISOUT
Mumhbar of WOLOO3 NONE MODISOUT
char. typad Operator Motes for Action
;-n:tubte ™ 38 of 255 max characters
sl for change in action__ |

Clickto change tha
spacified volumea of
tha salacted davice

to Assign or to Mount. B

Assigned 0300082374 VOLOOY
[] Mount 0300082374 VOLOO

Actrate Reguest Cancel

104
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OM GUI

Physical Media Distribution (cont.)

O PMD — Media Creation Console

» Procedure: Using the PMD Media Creation Console (cont.)

» Once action completes processing (request moved back to console left-pane Request Actions)
its labeled under Action Type as Collection Media for QC.

> 2"d Collection Media for QC: Under Options, select Media Collection Complete from list. The
Media Collection for RequestID <number> dialog box prompts, click Media Collection
Complete to initiate Transferring.

) hitp://f4oml01. hitc.com:22441 - Action: Collect Media For OC - M... [= |[B]X]

Media Collection Complete for RequestiD 0800017533 \

Volume Volume Production Production Select For
Name Status Module Device Qc
a

Operator Motes for Action

0 of 255 max characters

Media Collection Complete I Cancel |

Daone
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OM GUI

Physical Media Distribution (cont.)

O PMD — Media Creation Console

» Procedure: Using the PMD Media Creation Console (cont.)

* Once processing completes, request (moved back to the left-pane Request Actions) is now
labeled under Action Type as Activate Media for QC.

> 3'd Activate Media for QC: Under Options, select Activate QC from list. The Activate QC
RequestID <number> dialog box prompts, click Activate QC to move request (and create
volume) to right-pane Device Actions for action. Click OK to confirm action at prompt. Then locate
request associated with specified Media Type Device, then click Assign checkbox to assign
volume to the device and to initiate QC Hold.

) hitp://f4oml01.hitc.com:22441 - Action: Activate Media for oC - M. [= |[B][X]

Activate QC for RequestiD 0800025507

| e

Volume
Name

Volume Production
Status Module

Production Select For
Device Qc

<

Operator Motes for Action

0 of 255 max char

The page at http://ff4oml01.hitc.com: 22441 says:

Activate QC |

Selected volume 0300025507 VOLOD 1 was created on this device 00500 144

{ ‘.’
)_,'-/] Do you want to continue?
Cancel

L —V

Cancel | v

Done
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OM GUI

Physical Media Distribution (cont.)

O PMD — Media Creation Console

» Procedure: Using the PMD Media Creation Console (cont.)

* Once processing completes, request (moved back to the left-pane Request Actions) is now
labeled under Action Type as Assemble Package.

> 4th Assemble Package: Under Options, select Mark Request Shipped from list. The Mark
Request for Shipped for RequestID <number> dialog box (A) prompts, click Mark Request
Shipped to initiate Waiting for Shipment. Request status can be monitored/reviewed using the
Distribution Requests page (B), tracked by the RequestID <number>.

¥ hittpc /o) hHrpome 1441 - fcBion; Aasemble Packepe - boorilla Firefon

mmmm&mhmug«nﬂ
g Track status
k]
of raquast by
[ Gt Package Asssowlad fuaud i ReguastiD
5 Distribution Hequasts
Prirted Ougats o Cument Filers
O My L .. OrderiCe loss Request IE: (20007533 E-Mhail: Nene Firal Hame: tiose Laat Mame: Hone
pe T b 11513 " Crmation Teme: Start: Dwc § 2007 064Pl Erct: apr 29 2008 01526 Order Type: ALl User BE Hont
o Rapartn 1161 ".HWFR e
Shipping Labsh Riple Khpcin Status
D o -, a5 "Options
= J Chianos Fitet Bufk Cancel | Bk Resubmi |
St % [I2alect A8 [Saleca Mona
2
Dpamor Kot Yor Actipan
0 of 355 mux charsttens
of 1iem Bna-_,h'.'l ¥ o a8 Bna
| Shewang 1-1 of 1] naed | last
Request Gran i s - Reahl -
o oy, Modia priocky| BSWEH | gopr | yeenn MME cosed  LomUpdsw | Actons
Qs d Sk s P _:__.--_._._ N M:Smf hﬁm
{ S |53 ool e oevenei| e [l % (Z | e
R e
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OM GUI

Physical Media Distribution (cont.)

O PMD — Device Configuration

» Displays the configuration of devices used in the Physical Media
Creation Console.

» Provides the Operator with a quick visual indicator of the load for each
Luminex device.

= Provides job limit parameter data that indicates the current load and
maximum number of jobs percentage based on device’s configuration.

» Physical Media Device: Device Configuration page displays information
in five sections:
1 — Production devices.
2 — QC devices.
3 — Production/QC devices.
4 — Unclassified devices.

5 — LUMINEX Device Loads:
e Allocated Work Load
 Actual Work Load

e
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OM GUI

Physical Media Distribution (cont.)

0 PMD — Device Configuration
» Procedure: Filtering/Modifying PMD Device Configurations

> Click Physical Media Distribution, then submenu Device configuration to display the Physical
Media Distribution: Device Configuration page.

s*Figure: PMD: Device Configuration Page

Physical Media Distribution: Device Configuration
A Ve Dvios.
Fier [“radatyi— @ [-comesuna- v [—seveesuua— v Apphy | cew | i
Device Label |Current Request [Volume]  MediaType | Reserred For Mode Used By Mode Device Status Dnline Status Offline Reason
Production devices :
@ sidf - sfsdt | |COROM | ® | ovin
 FAKECDROM-DELETE | {Sh | ‘ 2 |oriin
@ JAMES TEST - PLEASE REMOVE MEI| |COROM (LUMINEX)  DEVO2 | | ® |ondin
@ cdro m1 |COROM (LUMINEX} | | ® | aviin
Deetg | | 1 _® |orine
D Luminex7100 | COROM, DVD (LUMINEX) | D Jordin
QC devces
@ gh | COROM |2 ] ortiny
D | COROM | Jortin
@ piscaC | COROM. DVD |2 Jortin
T DiscQC2 COROM. DVD | FREE | i
D DiscQCZ5im [ COROM. DVD FREE | = | or-tine
@ UnixDiscOC | COROM. DVD | FREE = Jorline |
D MADEUP - Mado up devics for 1 | oLt |FREE ® | o1
Production/QC devices E
@ rz200LT1 oir |DEVI4 |Ts2 |BUSY ® online
@ 7200LT2 oLt | | |FREE D |ondine |
© CHECKOUT_DLT_SIMULAT | ot |Ts2 | | FREE | | ondine |
® pEVo2_SIM i ot |DEV02 1 |FREE _® Jondine
@ DEVOS_DLT_SIM - Iz a test e fo | ot |DEV06 | DEVOG |BUSY B londine
O DEVOG LTSt o |oeves | |rREE | ® |on
D DEVO6_DLT_SIM2 e |DEVOT | |FREE ® | ondin
unclassiied devices.
- no devices -
LUMINEX Device Loads |
0% 50%: 100%
E£s TEST |
located Work Load (73.0 of 4 max MB) T
Actual Work Load (0.0 of 6 max MB) 00% |
mt
located Work Load { 0.2 of 20 max MB} 10% §
Actual Work Load { 0.0 of 10 max MB) 00% |
it : e
located Work Load { 6916 of 800000 max MB) 0.1% |
Actual Work Load { 1789.9 of 800000 max MB) 02% |
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OM GUI

Physical Media Distribution (cont.)

0 PMD — Device Configuration

» Procedure: Filtering/Modifying PMD Device Configurations (cont.)

> To change on-line or off-line status of
a device: Click the Device Label to
display the PMD: Device Configuration
Details page.

s*Figure: PMD: Device Details Page
and Status Prompts

> Then locate and click the Online Status
(green or red) status button. At prompt:

> If taking device off-line: Type
justification in textbox, then click
the Apply button to change the
status and dismiss the prompt.

> If placing device on-line: Click OK
to continue and dismiss the prompt.

> Click Apply button, at page-bottom to
return to the PMD: Device
Configuration page.

> Click Apply button, at page-bottom to
return to the PMD: Device
Configuration page.

625-EMD-204 Interim Update 1 — LaRC 7.21

MADEUP

o]

_Physical Media Distribution: Device Canfiguration

[ Back to Device List | Davice Details

Devica Label| MADEUP
Device Purpose|| QC »
Dece Status FREE

Online Status| _ @ J oft-line ) ; ; =
Ofine Reason 5 The page at http://f4oml01.hitc.com:22401 ... [g|
Denace PIﬂI: ab/a

Reserved for Mode [ (ALL MODES) v l/_,j

O COROM

O ovD
et i (‘ COROM and DVD
@ o

2 ‘fou are about to place this device on-ine. Continue?

i Cancel

PC Anachld Oyes @ n
Device Deszrption 105 of ?55.'r'!x.=h.a.@§fe!!_
Made up device for testing ncr
TO4E938. If Katie forgets to delete this
in by friday, please remind her,
|

_Apoly | _Cancel | Resut |

1200072 | [ Assign[oxecenimivowosr  ~ | [ Assign [c3c0082143 vorot | ondine

\ Physical Media Distribution: Device Configuration

[ Back to Device List | Device Details

Device Label 7200072
Device Purpose: | Production a nd QC v

Device Staws, FREE

Onling Status. J

) hittps /i 4omi01. hite..com:22401 - OMS GLI - Mazilla Firefox =1

Piease type in an explanation for taking this device off-line:
Warning: /f this device is busy, the cument Request wil be complefed before
the device 15 faken off-fine.

Device Path fdevistd
Reserved for Mode | (ALL MODES)
Media Typ| @ oL

Device Description 1 0f 255 max characters

1 o camet]

_Apply | _Cancel | Reset |
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OM GUI

Physical Media Distribution (cont.)

O PMD — Device Configuration

» Procedure: Filtering/Modifying PMD Device Configurations (cont.)

> To add a new device: Click the Add New Device... button, at left-top of PMD: Device
Conflguratlon page to display the PMD: Add New Device page:

Physical Media Distribution: Device Configuration |
7 [~ osion stanis — o [ cavn staa — vﬂlml
[Current Request [Volume]  Media Type  Reserved For Mode Used By Mode Device Status Online Status Offline Reason|
D sfdf il B | |coROM . | ovine |
@ 1 i | -~ 5
FAKECDROM-DELETE | P[’W"J ical Media Distribution: Add New Device | | - oriine |
@ JAMES_TEST - PLEASE Prosrepmsmpy | ondine |
@ cdro m1 il e Device Purpose . | O |ovine | |
O Devce e TR [ o
@ Luminex7100 | dac = , E
isction ond QL ! 2 |
B 1 | Add Mew Davice Pages: Production (B1), QC (B2), and Production and QG (B3). I
Device P
Device Purpose: |Production iv] B3
Device Type: O CD/DVD O Tape DR PR
B2 --------- Device Purpose: |Production and QC | v |
Device Purpose | ac v | . ion/QC Devica Details
Media Type: O DLT
Q€ Dewce Details Device Label
Media Type: O CDROM Device Path: |
O DVD Resenve for Mode
©OCDROM and DVD (optianal), | ALL MODES) [+
O DLT Device Description:
PC Attached: O yes @ no [
Device Label
Device Path: |
Reserve for Mode ,“‘““*‘*““""“‘"
{optional) (ALL MODES) v
Device Descrip '
0K | _Cancel |
OK | Cancel
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OM GUI

Physical Media Distribution (cont.)

O PMD - Device Configuration

» Procedure: Filtering/Modifying PMD Device Configurations (cont.)
> Click the Device Purpose list box to display its options. There are three device purpose types:

1 — Production.
2 —QC.
3 — Production and QC.

» Click desired Device Purpose from the list box and complete its options and input fields.
Then click OK, to add the new device.

> Return to the Order Manager Home page, on left-pane of OM GUI click the HOME link.

|
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OM GUI

Physical Media Distribution (cont.)

4 PMD — Open Intervention
= Operator can view and respond to several Open Physical Media (PM)
Interventions:
Change any/all volume status (pass or fail)
Fail or change any/all granules in a volume
Restart media creation
Continue media creation with selected volumes.

» The Open PM Interventions page has three working parts:
1 — Current Filters — pre-defined filter criteria.

2 — Options — features to change an individual or combined filter
and to bulk fail or bulk submit requests.

3 — Listing — captures requested distribution of filtered output.

|
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OM GUI

Physical Media Distribution (cont.)

4 PMD — Open Intervention

» Procedure: Responding to Open PM Interventions

> Click Physical Media Distribution menu, then submenu Open Interventions to display the
Open Physical Media Interventions page.

> To display details pages for Order ID or Request ID: Under the Listing section, click on the
underscored <ID> to display its detailed page:

« Figure: Detail displays of Request ID (A), Order ID (B), Filter (C)

A Intervention For Request 0300082263 |
g ID: ECSGuest Benjamin tko@rayt
R-:::;:ID:I:M] e ;::Lz:mmm W M‘M"w onsen] 3 http:/ff4oml01. hitc.com: 22401 - Open Physical Media Inter.... [ |[B1]f5]
Input Size: 933 estimated B Acknowledged: Open Physical Media Interventions Filters
Media Type: COROM Request Status: Operator Intervention vid
Priority: NORMAL Metadata Format: 0oL = i :T LAl
Explanation(s): Media Callecton Faied ThiChange o madaeiiratl -
. x anothar status, the e
Worked by: - rotersuigees. | 2550 “Worksd by must
o | be assignad _cmer |

ams || Stws || ChengeTo..| || 'Explanstion || PraducionModule’ || Production Davic | Combined Filters
CREATED [w] FaiLEn Intervention Creation Date Filters

2 granues ! ! il - TS
CREATED O FuiLED 0 ¥ 3 WM T w1
20 ganuen...
= Mooth  Day  Year How Wi
Link displays EaTre o1 v w208 v 1T v
Granule List Request Level Disposition

© Ksep on hoid If “Fail this Distribution Raquest™

© Fail this Distribution Requost —————————————»|
© Retry media creation for entire Distribution Request [ O Dont send DN )|
© Retry media crea umes

Operator Notes

Boply | e e | 2|
= =
B ECS ORDER 0300084004
Request ID: 0300082263
Order Type: Regular Start Date: ot available Tk
Order Source: OmSCliDriver User ID: | ECSGue: E
Ext. Requestld Not available Status: ' Pending e
Receive Date: Jul 20 2007 12-16PM Ship Date: Not available
Last Update: Jan 28 2008 11:39AM | Order Home DAAC: RBD
ot CIT Frga . E N
Description: Not available Displays Detailed ECS Order Data:

=Distribution Ragquast <I0> data
=¥oluma Listwith Requast Notes; Mailing/Shipping/Billing Addrass info
=Failed Granules List (DPL Granule ID) datails.
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OM GUI

Physical Media Distribution (cont.)

=5

O PMD — Open Intervention

» Procedure: Responding to Open PM Interventions (cont.)

> To fail intervention(s): On the Intervention For Request <ID> detail page, under Options
section, click either the All (Bulk Fail) checkbox to fail all interventions or the individual %Sel)
checkbox(es) associated with specific intervention(s), then click the Bulk Fail button. In the
Confirm Bulk Fail Action dialog box, enter Operator Notes and/or Additional e-mail text in
textboxes, as appropriate. Select Send email option to notify users whose requests are being
failed, then click the Apply “Bulk Fail” button.

> To submit intervention(s): On the Intervention For Request <ID> detail page, under Options
section, click the All (Bulk Submit) checkbox to fail all interventions or the individual
(Sel) checkbox(es) associated with specific intervention(s), then click the Bulk Submit button.

> To check granules in a volume:
Click the Volume Name [<number>

) http://f4oml01. hitc.com:22401 - Granule List for Yolume VOL0O? of Request 0300082264 - Moilla Firefox

H =] close window
granUIe'”] Ilnk under the Reql."leSt ID Granule List for Volume VOL002 of Request 0300082264 |
etails page Volume List section. The
Granule List for Volume Window Grane Lis
displays. After review, click x-close oo secty oo ok [ortarm  shon[2 ¥ matatme
window to close granule window e —————
:
> To free-up a device: On the Intervention g5 25— F28 8 = 7 2 =
For Request <ID> detail page, click 24 a5 AC_PusCION_SC 500z STAGED Fail
[deallocate this device...] link, adjacent = MoOSPMS_EC Ei - =1t
Egéhe %Urren%Dth[Ce gntlryl tgen CIICk 124425 158089 Momwm:uas sC 0:104 STAGED Fail (1
in the confirmation dialog box. Selectall L]
> Return to the Order Manager Home St | veicus | Showing 1- 12 131 et st Smmmi
page, on left-pane of OM GUI click
the HOME link.

1
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OM GUI

Physical Media Distribution (cont.)

O PMD - Printer Configuration

» The Printer Configuration page handles the configuration of printers
used in physical media distribution.

» Printer configuration features two actions:

- Add printers. Physical Media Distbution: Printer Configurat
- Edit printer parameters. p—E L :
% Figure: PMD Printer Configuration L’:’;Eﬁ
Page and activity displays TP TP EISTEIY "cr  woe ri on s vy
g Teeiemm e < Aeply | _Conceleon |

Cancel Edit button, toggles

=1 T B “Edit parameters.. " fislds
onioff page
Name | Type | Network Info | Status Options
et bw-A151 Packing List nomal printer I |Always print
[t adit_buttan ac nomal printer | /Always print
displays the “Edit Always print
parametaers.. "fislds
onthe pags. ERROR: This printer has an
adit. ffﬂﬂﬂﬁ |Shipping Label wider of the two label printer. .. option of "Always print” Only
Packing List and QC printers
‘are allowed to have these
options!
Always print
\ERROR: This printer has an
ecit.. | f2tek750 Jewel Case eventually we will use f2tek75... option of "Always print” Only
Packing List and QC printers
\are allowed to have these
(options!
Always print
ERROR: This printer has an
esr.|2dpl07 Tape Label \has smaller label roll. The on. . option of "Always print” Only
Packing List and QC printers
‘are allowed to have these
B I il Jii _options!
edit.. | bw-1151 Always print
ool Awasysprint

]
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OM GUI

Physical Media Distribution (cont.)

O PMD - Printer Configuration
» Procedure: Modifying Existing PMD Printer Configuration

» Click Physical Media Distribution menu, then submenu Printer Configuration to display the
PMD: Printer Configuration page.

> To edit parameters values: Click the edit... button associated with printer (hame). In displayed
printer parameters window, change the following values:

> Name = <new_printername>.
> Network info = <new_network_text>.
> Options: select only one.

» Always, if designated as default module (for packing List and QC printers only).
* Never, if not default module.

* On QC Error Only.

> Click the Apply button to implement changes, then click OK at the update confirmation
prompt.

> Return to the Order Manager Home page, on left-pane of OM GUI click the HOME link.

|
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OM GUI

Physical Media Distribution (cont.)

0 PMD — PM Configuration

» The PMD Module Configuration page displays information for all
currently configured production modules. The OM GUI handles the
configuration of production modules in physical media creation.

» Production modules can be “added” and parameters values “edited”.
s Figure: PMD Production Module Configuration Page and Add Toggle Fields

Physical Media Distribution: Production Module Configuration |

|Add New Production Module| |
The page at http://f4oml01.hitc.com: 22401... El
[ Cancel

“Add New Production Module | 3. Production modue successfilly added.
Cancal ILrlk, Na‘ms [ (L]
Logg\ff_g_ifit?di *-aJmage File Path I =)
onioff paga. Text File Path Il ;
Pefault Module Cyes Ono_
Add This Production Module
MODISOUT  (ID: 1)
Hame |MODISOUT |
Created |Feb & 2005 T 38PM |
Last Updaled _ |Mar 20 2008 5: 28PM |
Image File Path _|MODISOUT_JCI_TEMPLATE _|
Text File | Path E}Eopc_zun_viui [ il
Emcut bla |EcOmPdModule |
Default Module. _|Oyes Ono |
Apply Changes I Reset I

ASTEROUT  (ID: 2)

Name |ASTEROUT
Created [Feb 8 2005 7:38PM _
Last Updated |Mar 15 2005 1:50PM
Image File Path §Fs1'enou1_;cl_1mpu.ﬁ
Text File Path |ASTGENDVD.txt
Executable |EcOmPdModule
Default Module _Qy_eg i no

Apply Changes | Reset |

|
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OM GUI

Physical Media Distribution (cont.)

0 PMD — PM Configuration
» Procedure: Adding/Modifying PMD Production Module Configuration

> Click Physical Media Distribution menu, then submenu PM Configuration to display the
PMD: Production Module Configuration page.

> To edit assigned parameters values for a production module: Type <new_vaules> in
corresponding Image File Path and Text File Path textboxes. Change the production module
default, as appropriate: yes to set as default (or no as not being the default module). Then click
the Apply Changes button to implement edits.

> To add a new production module: Click the Add New Production Module button, add
<appropriate_values> it textboxes. Select <default> option, the click Add This Production
Module button implement new module. At confirmation prompt, click OK to acknowledge.

> Return to the Order Manager Home page, on left-pane of OM GUI click the HOME link.
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OM GUI

Physical Media Distribution (cont.)

0 PMD — Reports
= A HTML display using the web browser print menu function.

» Report Summary page has two display types:

1 — Device Report — summary of device statuses: on-line/off-line and free/busy by
media type.

2 — Request Summary Report — displays a quick summary of the PMD requests
(in states) from waiting-for-a-device to waiting-for-shipment.

s Figure: PMD Report Summary Page
Physical Media Distribution: Report Summary

Use your browser's print function fo print this report (File = Print...)

Device Report

offline  on-ine Free  Busy
CDROM 0 19 10 0
EBET 1 24 20 5
VD 0 . 9 0

Request Summary Report

_“Bfnrq“.-nnlp'lﬂ\mﬂnn' 1  Media Production

CDROM 1 0.245
DLT - 57 018
e

625-EMD-204 Interim Update 1 — LaRC 7.21 120




OM GUI

Physical Media Distribution (cont.)

0 PMD — Reports

» Procedure: Printing PMD Reports

> Click Physical Media Distribution menu, then submenu Reports to display the PMD: Report
Summary page.

> To print a PMD Report using the web browser: First, reload the page to ensure the most current
statistics are captured. Next, select File, Print (Figure B) from the menu, then select printer
(and set printer properties, as needed). Click OK to print (Figure B1-B2).

> Return to the Order Manager Home page, on left-pane of OM GUI click the HOME link.
ssFigure: PMD Report Summary Print Menu (B) and Progress (B1-B2)
B

mﬁ.ﬂ-t Wiew  Higtory d

B Wirsdony Crl -+
M Tady Cirl+T
Cipen Lneatinn S+

Open Fle, .. Cerl+0
Cloge Cirl +wW

Save Page As... Cl+s
Save Erame As...

B1

Tide: http:fifeomi0 L. hitc.com: 2240 1 fcgi-bin /EcOmGuitiay.pl
Progress: | i e - - - .- o WM. 100%

L= bt

625-EMD-204 Interim Update 1 — LaRC 7.21 121



OM GUI

Physical Media Distribution (cont.)

0 PMD — ESDT Configuration

» The full-capability Operator is allowed to add or remove names of ESDTSs,
which are stored in compressed format, to/from the PMD ESDTs page.

% Figure: PMD Compressed Format ESDTs Page

Physical Media Distribution: Compressed Format ESDTs

A ESDTs in Compressed Format
ESDT Name
AE_LAND 086
ES_LAND.001

ES_LAMD03.004 y
G I D The page at http://f4oml01.hitc.com:22441.... [X]
MOD13A2 004

A1

: O|0|= |08

}:’ Are yous sure you want tofdelete the selected ESOTS?

b N
O[moDtsat \ |
[] Select All M\Wﬂ ‘ NewESDT: [MODHA4 - - -mmmomimm oo » AddESDT ||
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OM GUI

Physical Media Distribution (cont.)

0 PMD — ESDT Configuration
» Procedure: Adding/Deleting Compressed Format ESDTs

> Click Physical Media Distribution menu, then submenu ESDT Configuration to expand the
Physical Media Distribution: Compressed Format ESDTs page.

> To add ESDT to the PMD ESDT list: Enter <new_ESDT_name> in New ESDT textbox, at right-
bottom of page, then click the Add ESDT button. At prompt, click OK to acknowledge the
update. The ESDT list updates.

> To delete ESDT from the PMD ESDT list: Check one or more ESDTSs on the list, click the Apply
Deletion link, at left-bottom of page, then at prompt, click OK to acknowledge the deletion. The
ESDTs is deleted from list.

> Return to the Order Manager Home page, on left-pane of OM GUI click the HOME link.

|
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Order Manager GUI

View Order Status

J OM GUI — View Order Status

» The OM GUI Order Status page allows the Operators (Full or Limited-
capability) the ability to monitor and/or view the status of orders
submitted via the OM GUI.

» The Operator can view detailed information in three status levels:

— Order Status
— Request Status
— Granule Status.

= View Order Status submenu:

— OM GUI Order Status.

s Figure: Get Order

Status Page

Get Order Status

—_—

® GetOrderStatus | Reset J—‘

/ Toget an order history (a listing of past orders with status), select either the number of

Generatas saarch

{of current or
histarical status)
on spacified field

antry.

¥

625-EMD-204 Interim Update 1 — LaRC 7.21

-'"_ Mumber of Days hg

% BeginingDate |

(MM/DDAYYYY)
\ EndDate | (MM/DD/YYYY)
@ GetRangeofOrderStatus | Reset —

Enter the Order D |

F

Clears antryfislds. I

—_—

days fo look back (from today) OR select the date range

: MNOTE: Use amail Id associated with ordar. I_
Enter The Email Id

- OR -

Clears antryfialds.

Getcurrent status of
pending andfor
currant ordars.

Get historical status
of past andior
completad ardars.
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OM GUI

View Order Status (cont.)

O View Order Status — OM GUI Order Status

» Provides a visual display of viewing multiple levels of a particular order
status

» The Operator can search through to the lower levels of the order, the
status path is capture as a navigation bar.
oo Figure: Get Order Status A] STATUS FOR ORDERID: < Orderl D>

Pages Navigation Bars | Search fr S1stus>>Order Status |
a.nd F|e|dS M1 A3 Status pagas
A ORDERID:<OrderlD > STAUS: <status> COMPLETIONTIME: Mavigation Bars {at top-
laft of status page).

!sﬁ-—: for Status »=>Order S1stus >>>Request Status

As ORDERID: < OrderlD = REQUESTID: < RequestiD > REQUESTSTATUS: <StatusType = MEDIA: <iMediaType > COMPLETIONTIDAE:

Search for Status >>Order Sistus >>>Request Siatus >>>>Granule Status‘

1 3
. Order Status n Request Status . Granule Status

Fialds Field= Fislds
ltam Mumber tam Mumbear tem Mumber
OrdarlD RaquastiD Granulald
Submitted Status ShortName
Status Media WersionlD
Completed GranuleCount SizeMD
Associated Raguast Complatad Status
Associated Granulas Procassing
Procassing
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OM GUI

View Order Status (cont.)

O View Order Status — OM GUI Order Status

» Procedure: Viewing Distribution Requests Order Status Pages

> Click View Order Status menu, then submenu OM GUI Order Status to display the Get Order
Status page.

> Toretrieve a current order status: First, Enter the Order ID using a complete 10 digit order id.
Next, click GetOrderStatus button to retrieve the most current status and to display the STATUS

FOR ORDERID:<OrderID> page. [MI A C
. i . EAE M i — o Order List
> To retrieve the status of a historical*=* [Sese & 5>>Order Status | -
order: First, Enter the Email ID o ] OR mt B | ERROR (more Error Details )
address (id must be associatedwith "~ | s s ot
an historical order) and select(the — - _— —
number of Number of Days fr the/-,@;aﬂ_.
list box — select 30. Or, enter a | STATUS FOR ORDERID:0300084004 IB1
Valld range USIng the Qfal;lc:;r?:m»g;a:itftt:jtuq Status |Completed |Associated Request T
Beginn i ngDate (M M/DD/YYY ) 1(0300084004 | Jul 20 2007 12:16PM [Pending] . 0300082263
and EndDate (MM/DD/YYYY) e
text fields. Next, click the e e e PR _
GetRangeofOrder Status button L — | e | .-_s_-\i.rrd.ﬂfvsrvmw-vmm
to retrieve the most current status — se.is = caseime ——
and to display the Order LiSt page § Gueis = sumites [ siis Teompioiea Assosiseaes
of related historical status(es) 1] Goouesseg | kil 2007 t1AZAM | Concoied (| |usootazzs0 |
) 2/0300083993 | Jul 20 2007 11:42AM | Canceled | | 0300082251 |
.:. Figure- Order StatUS PageS 3|0300533991 Jul 20 2007 11:42AM | Canceled | | 0300082252 |
’ 40300083994 | Jul 20 2007 11:42AM | Canceled | | 0300082253 |
(A-BZ) 5| 0300083996 | Jul 20 2007 11:42AM | Canceled | | 0300082254 |
first | previous | Showing 1 - 5 of 47 | next | last |
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OM GUI

View Order Status (cont.)

O View Order Status — OM GUI Order Status

» Procedure: Viewing Distribution Requests Order Status Pages (cont.)

> To retrieve the status of a current order detials: First, Enter the Order ID 10 digit order id from
the Get Order Status page (Figure A). Next, click GetOrderStatus button to retrieve the most
current status and to display the STATUS FOR ORDERID:<OrderID> page. Click the
Orderld<number> under the OrderID column to display the Listing details of the Request
Status (Frame C)

> To retrieve the Granule Status (Frame D). Click the RequestiID<number> under the RequestID
column to display the details of the Granule Status.

> Using the navigation bar, click the Search for Status link to return to the Get Order Status page
(Frame A) and to perform other order status searches.

> Return to the Order Manager Home page, on left-pane of OM GUI click the HOME link.
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OM GUI

View Order Status (cont.)

O View Order Status — OM GUI Order Status

» Procedure: Viewing Distribution Requests Order Status Pages (cont.)
ssFigure: Order Status Details Pages (A-D)
A

Get Order Status

|Enter the Order ID joso00a4004 |

GetOrderStatus | Reset |

STATUS FOR ORDERID:0300084004 |
Sesrch for Status>>0rder Status

#|Orderld _|Submitted |status |Completed |Associated R

[B-+C) Bot Reguast Status I————‘IUEGDUMUM Jul 20 2007 12:16PM |Pending| ‘[}300082263

\ ORDERID:0300084004 STATUS:Pending COMPLETIONTIME:

s for Ststus >>Order Status >>>Req Status
Listing

Show |5 W rows 81 8 time.

m;mmhmw 1-1001) paut| lost

| | | 124378, 124379, 124380, 124381, 124382, |
124383, 124384, 124385, 124386, 124387,
124388, 124389, 124390, 124392, 124393,
Orerator | 124394, 124397 124398, 124415, 124416,

1| 0300082263~ PErAtr | COROM: 41 124419, 124421, 124423, 124425 124427 N
124428, 124431, 124432, 124434, 124435,

124437, 124439, 124441, 124443, 124444,
124445 124446, 124447, 124448, 124449,
124450

frst | privious [ Showing 1-1of 1 next last | D

‘ORDERID:0300084004 REQUESTID:0300082263 REQUESTSTATUS:Operator
(0-D) Get Granuls Btatus Intervention MEDIA:CDROM COMPLETIONTIME:
M'Sda ch for Status >>Order Status >>>Reqguest Staiws *>>>Granule Status |

Listing
Show[f v rows st s time.
£ | evic | Showing 1 Bl 1| cact | lan

ranulel _“_m_pmau SizeMB Staws | Processing
1124392 |MOD29 |86 | 0.102077484130859 |5TAGED N
2124394 |MOD14 |86 | 0.68387508392334 |STAGED N
3124397 [MOD14 |88 |0.464058876037598 | STAGED |
4124398 |MOD14 |86 |0 6037596 | STAGED |N
5124427 |MODY |86 | 0.68387508392334 | STAGED |N

first | previous | Showing 1 - 6 of 41 | nexd | last
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Order Manager GUI

Logs

d OM GUI - LOGS

» The OM GUI Log keeps record of every page run and every stored
procedure called within those pages.

» The log aid the System Administrator in problem resolution when errors
are encountered.

— EcOMGui.log is the log filename.

— The log file path is typically in directory [/usr/fecs/MODE/CUSTOM/WWW/OMS/cgi-
bin/logs] on the Data Pool Server host [x0dps01] where the OM GUI is installed.

* Logs submenu:
— OM GUI Log Viewer.

|
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OM GUI

Logs (cont.)

U Logs — OM GUI Log Viewer

= A convenient diagnostic tool that displays all current activity in the OM
GUI and allows the Operator the capability to view entries captured (from
page runs and stored procedures) in the log file.

» The log file that the log viewer displays is located under the [cgi-bin/logs]
directory where the OM GUI is installed:

— It is not the web server log or the SYSLOG.
— ltis a log [EcOmGui.log] that is specifically generated by and for the OM GUI.

» Procedure: Viewing the OM GUI Log
> Click Logs menu, then submenu OM GUI Log Viewer to display its page

> To view the log file: Enter 20 in the View the last line(s) of the log file textbox, then click
the OK button to generate a 20 page history.

* NOTE: The log viewer’s functions similar to that of the UNIX “tail” command — the number of lines need to
be seen must be specified. Otherwise, if O is specified or left blank the entire log file will display.

> Return to the Order Manager Home page: on left-pane of OM GUI, click the HOME link.
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OM GUI

Logs (cont.)

U Logs — OM GUI Log Viewer
s Figure: OM GUI Log Viewer Page (A) and Log File Display (B)
OM GUI Log Viewer

;\ 3,300 ME
33748 ines
Last modified on Sat Aor 8 13:18:16 2005

View the last 20 line(s) of the log file. oK |

Leave blank fo wiew entire fog

B Viewing last 20 lines of the log file:

[+ showline numbers [lastline] |q— Linenumbers
display option.

33727:([Sat Apr 9 13:16:16 2005] EcOmCuiPmdactions.pl: Use of uninitialized vg
33728:[Sat Apr 9 13:16:16 Z005] EcOmGuiPmdactions.pl: Use of uninitialized vs
33729:#*% x#x% EcOmGuiPmdActicns: Input Parameters on Entry ##*
33730:autcRefresh == off

33731:refreshrate => 5

33732:sessionld => ralphadmin

33733:8at Apr 9 13:16:15 2005 There are NO selected action tvpes
33734:8at Apr 9 13:16:15 2005 GetPhysicalMediaDataFromDB: sgl is

Displays last 20

R { gg;gg DECLARE @Total_Requests int

il vl 33737: declare @total_output int
33738:
33739: EXEC OmGetMediadectionList
33740:
33741: Asortact ion="DueDate",

33742:6Request_Id No = 1,

33743:ebatchsize = 50,

33744:@8creen_Acticon = "C",
33745:eInterventionTypeList = "ALL",

\ 33746:aTotal_Requests = @total_ocutput cutput

- —
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Order Manager GUI

Logs

d OM GUI — Admin Tools

* The OM GUI Admin (Administrator) Tools page controls Operators’
profiles and configuration for every filed, on every page that is generated
within the OMS GUI.

= Admin Tools submenus:

Server/Database Parameters — to check and modify server/database parameters
values.

Media Parameters — to check and modify media parameters values.
Aging Parameters — to configure aging parameters (rules) values.
FtpPush Policy — to set permissions for FTP Push Policy Configuration Pages.

Actions Pages — provides a set of predefined permissions to set, remove, suspend or
resume any/all related actions and/or related configurations on any/all related OM
GUI pages

» This page is restricted for use by the site Administrator only and will not
be trained.
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